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1 Introduction

Disk images pack entire folders or disks into a single compressed file, either for transport across the
Internet or simply for backup. They are Apple’s preferred format for distributing Mac software.
Disk images are also the only archive format whose contents you can directly access in the Finder,
without the potentially slow and disk-consuming step of expanding the files into a folder.

DropDMG is the easiest way to create Mac OS X disk images, as well as cross-platform archives.
Just drag and drop a folder or file and you’re done. Or, you can drag an existing disk image or
archive onto DropDMG to convert it to any of the other supported formats or to burn it to CD or

DVD.
DropDMG supports advanced options such as encrypted and segmented disk images, background
pictures and custom volume icons, and rich-text license agreements in multiple languages. There

are many time-saving features such as configurations to keep track of your favorite combinations
of settings. It can also be automated via AppleScript, the command-line, and Automator.

1.1 Feature List

The following is a partial list of DropDMG’s features, so that you can quickly see what it can do

and how it’s unique:

Overview
e Create and convert disk images and archives with a simple drag and drop. There are
also many other convenient ways to invoke DropDMG.

e DropDMG supports all the major formats, including compressed . dmg files, . sparsebundle
files, .zip and .tar.gz archives, and hybrid disk images. Zlib disk images and ZIP
archives created by DropDMG are smaller than those created by Disk Utility and the

Finder.



e Configurations let you reuse common collections of settings, and temporary options let
you easily make one-off changes.

e Quickly burn files, folders, or disk images to CD or DVD. Multi-session support lets you
add files to an existing CD.

Delivering Software

e Create .dmg disk image files, Apple’s recommended container format! for deploying Mac
OS X software.

e Design reusable layouts with background images and pixel-perfect icon positioning. Add
text boxes with custom fonts, styles, shadows, and variables.

e Apply a license agreement that Mac OS X will display before the user can install your
software. Licenses support rich text and multiple languages.

e Automatically renders a custom volume icon that badges your application’s icon onto
the white disk image icon, with the proper 3D perspective.

e Make your disk images Internet-enabled so that Safari automatically expands them into
a folder after download.

e Burn CDs and DVDs with background pictures and icon layouts that auto-open when
the disc is inserted.

e Store your license agreements and layouts in open formats (RTF, XML) under version
control.

Backups, Archival, and Cloning
e Disk images preserve Mac-specific metadata: resource forks, Finder labels, creation

dates, ownership, extended attributes, etc.

e Save disk space and network transfer time by compressing your files. Choose faster or
more efficient compression.

e Split large files or folders into multiple segments to burn them to optical discs or easily
transfer them over a network.

e Verify the integrity of your backups and archives to ensure that the media is still intact
and that you’ll be able to restore them if needed.

e Create a device image that records the exact contents of a data CD or DVD. You can
then burn bootable backup copies of the disc, or double-click the disk image to access
its contents as though the disc were still in your optical drive.

e In one step, create a device image clone of an entire hard drive, optimized for restoring
using Apple Software Restore or Disk Utility. This is useful for backups and for setting
up multiple computers in a lab.

e Optionally enter your administrator password so that DropDMG can back up all your
files, with proper permissions and ownership, while unattended.

Encryption

"Mttp://developer.apple.com/mac/library/documentation/developertools/conceptual/softwaredistribution/Containers/
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e Encrypt files that you want to keep private. DropDMG’s encrypted, writable disk im-
ages are faster and safer than Apple’s FileVault, but just as secure and searchable via
Spotlight. Compact them to reclaim unused space.

e Create encrypted, compressed disk images to securely transfer files via e-mail, iDisk, or
FTP or to store backups safely off-site.

e Choose from 128-bit and 256-bit AES encryption, approved by the U.S. National Security
Agency.

e Optionally store your passphrases in the Mac OS X keychain, so that you can quickly
create and access encrypted disk images, without the hassle of double-typing or the risk
of typos.

e Mount disk images at specific locations in the filesystem, so that your applications can
keep their support files encrypted.

e Change the passphrase of existing encrypted disk images.
e Mount encrypted, segmented disk images without having to enter the passphrase sepa-
rately for each segment.

Advanced

e Runs multiple operations simultaneously, so you that you can keep working while DropDMG
processes in the background.

e Takes advantage of multiple processor cores for faster compression and encryption.

e Keeps a detailed log of all the successful operations as well as any errors, including
statistics such as the throughput and how much space was saved using compression.
New log entries are also reported via Growl?.

e Fast disk image mounting: turn off verification to quickly mount disk images, use shadow
files, and mount encrypted disk images without having to re-type the passphrase for each
segment.

e Get detailed information about your disk images: their formats, partitions, compression
ratios, checksums, etc.

e Easily queue up bulk operations for creating, converting, mounting, verifying, getting
info, burning, joining, etc. If multiple encrypted disk images share a passphrase, you
only need to enter it once.

e Make your favorite destination folders stay in the list of recent folders.

e Process the names of the output files to add the current date or make the filename
server-friendly.

e Automate via AppleScript, the dropdmg command-line tool, and Automator.

*http://growl.info
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2 Installing and Updating

2.1 Requirements

Mac OS X 10.5.8 or later is required. DropDMG is a universal binary that runs natively on both
PowerPC- and Intel-based Macs and is optimized for both 32- and 64-bit processors.

Note: When purchased via the Mac App Store, DropDMG runs only on Intel-based Macs and
requires Mac OS X 10.6.6 or later.

2.2 Imstalling DropDMG

Drag the DropDMG icon onto the Applications folder. Double-click the Applications folder to
open it. Double-click the DropDMG icon to launch it. Eject the white DropDMG-3.1.3 icon.

The DropDMG commands in the Services menu will become available the next time you log in.
DropDMG includes an optional dropdmg command-line tool. It can be installed as follows:

If you downloaded DropDMG direct from C-Command

Go to the Advanced tab of the Preferences window and click the Install “dropdmg”
Tool button. DropDMG will ask for an administrator password, as it needs to copy the
dropdmg file to the protected /usr/bin folder.

If you purchased DropDMG from Apple’s Mac App Store

Open the Terminal application. To install the command-line tool, enter this command (all
on one line):

sudo 1n -s /Applications/DropDMG.app/Contents/Frameworks/DropDMGFramework.framework/Versic

To install the manual, enter this command (all on one line):

sudo 1ln -s /Applications/DropDMG.app/Contents/Frameworks/DropDMGFramework.framework/Resous

2.3 Updating From a Previous Version

To update to the latest version of DropDMG, quit DropDMG application and then replace the old
DropDMG application file with the new one. That is, if DropDMG is installed in the Applications
folder, drag the new DropDMG application icon into the Applications folder and click Replace



when the Finder asks if you want to overwrite the old version. If you get an error saying that you
do not have sufficient privileges, drag the old DropDMG to the trash and empty it, and then drag
the new one into the Applications folder.

DropDMG 3.1.3 is a paid upgrade for registered users of DropDMG 1.x and 2.x. Discounts and
free updates are available depending on when you originally purchased DropDMG.

Note: If you purchased via the Mac App Store, you should update DropDMG using the App Store
application.

2.4 Uninstalling DropDMG

To uninstall DropDMG, drag its application file to the trash. DropDMG’s data files are stored in
the folder:

/Users/<username>/Library/Application Support/DropDMG/

or:

/Users/<username>/Library/Containers/com.c-command .DropDMG/Data/Library/Application Support/Dr
You can uninstall the command-line tool by typing:

sudo rm /usr/bin/dropdmg

in Terminal. You can uninstall the manual by typing:

sudo rm /usr/share/man/manl/dropdmg.1

in Terminal.

3 Using DropDMG

3.1 Basics

DropDMG automatically determines what you want it to do based on the files or folders that
you give it. The goal is to create an output file that matches the options you’ve chosen in the
preferences. For example, suppose you’ve set DropDMG to create compressed .dmg files:



e [f you give DropDMG a folder, it will create a .dmg disk image whose contents are the contents
of the folder.

e If you give DropDMG a volume, it will create a special device image (in .dmg format) that is
an exact copy of the volume.

e If you give it a disk image file (e.g. .dmg or .sparsebundle), DropDMG will convert it into
a .dmg disk image with the specified options.

e If you give it an archive file (e.g. .zip or .tar.gz), DropDMG will convert the archive into
a .dmg disk image.

e If you give it a file such as file.001, DropDMG will look for file.002, file.003, etc. and
join them into file.

e If you give it some other type of file, it will create a .dmg disk image whose contents are that
file.

When given multiple files or folders, DropDMG creates a separate disk image or archive for each.
To group multiple items into a single image or archive, move them into a new folder, and then drop
it on DropDMG.

So how do you “give” DropDMG a file or folder to work with? There are many ways:

DropDMG Window

Drag and drop onto the DropDMG window, or click the toolbar buttons. Control-click or
right-click on an entry in DropDMG’s log to operate on that output file.

Menu Bar

All of DropDMG’s commands are available in the File menu.

Dock Icon
Drag and drop onto the DropDMG icon in the Dock.

Finder Icon
Drag and drop onto the DropDMG application icon in your Applications folder. You can
also add DropDMG’s icon to the Finder’s toolbar.

Services Menu

Select a file in the Finder (or another file manager®) and choose DropDMG: Use Cur-
rent Configuration or DropDMG: Ask for Options from the Services menu in the
applications menu.

Contextual Menu

The services menu commands are also available when you Control-click or right-click on a
file. Requires Mac OS X 10.6.

3http://www.cocoatech.com/pf . php
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Keyboard Shortcut

Use the Keyboard pane of System Preferences to assign a keyboard shortcut to DropDMG:
Use Current Configuration or DropDMG: Ask for Options.

Automator

You can use Automator® to create workflows incorporating DropDMG actions. Frequently
used workflows can be accessed from a contextual menu in the Finder or saved as droplets.
DropDMG includes a Create Disk Image/Archive action for making new images and
archives, and also a Expand Disk Image action for converting a .dmg disk image back into
a folder.

AppleScript
In AppleScript Editor®, choose File > Open Dictionary... to see the scripting commands
that DropDMG provides. Example scripts® are available to show how the commands work.
Command-line Tool

You can install the dropdmg command-line tool from the Advanced preferences. To see the
available options, type man dropdmg in Terminal.

3.2 Making a Bootable Device Image of a Hard Drive

A device image is a special kind of disk image that is an exact, block-level copy of the source volume
and its filesystem, including features such as hard links and compressed system files. You can use
device images to:

e Create a complete backup of your Mac. Device images support compression, so you can
make the most efficient use of your storage, perhaps keeping multiple full backups on the
same drive. They also support encryption, so that you can store your backup off-site (thus
protecting against fire, theft, etc.) without worrying about anyone else accessing your sensitive
files.

e (Create a reusable image of a Mac, with everything installed and configured the way you want,
then clone it onto multiple Macs, e.g. in a computer lab, so that they are all set up identically.

Device images have several advantages over other formats:

e Device images are generally faster to create than non-device images containing the same files.

e You can back up a bootable hard drive, then restore the backup, and the restored drive will
be bootable.

‘http://www.macosxautomation.com/automator/
*http://www.macosxautomation.com/applescript/
Shttp://c-command.com/scripts/dropdmg/
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e You can restore a device image to a hard drive without any special software. Just boot from
the Mac OS X installation DVD that came with your Mac and choose Disk Utility from
the Utilities menu.

e Device images efficiently store linked files, so they’re great for archiving old Time Machine’
backups.

e You can use DropDMG’s Verify Image... command to check that the backup device is not
damaged and that you’ll be able to restore the files.

Since a device image is an exact copy of a drive, DropDMG has to make sure that the drive contents
don’t change while it’s making the image. In order to do this, it unmounts the drive, copies the data,
and then remounts the drive. The startup disk is always in use and thus cannot be unmounted.
To create a device image of your startup disk there are several options:

e Boot your Mac from an external hard drive. (It’s always a good idea to have a bootable
backup drive, anyway.)

e Run DropDMG on another Mac and use FireWire Target Disk Mode® to connect your Mac
as a hard disk.

e Use a utility such as SuperDuper? to clone your boot drive to backup drive, and then use
DropDMG to create a device image of the backup drive. SuperDuper’s Smart Update feature
can quickly bring an on-site clone drive up-to-date. Then you can use DropDMG to create
an encrypted device image of the clone for off-site storage.

To create a device image of a hard drive:

1. Go to the Configurations tab of DropDMG’s Preferences window.
2. Select one of the compressed .dmg formats.

3. For an encrypted backup, choose an encryption level and set a passphrase. Encryption
is highly recommended if you will be storing your backup off-site.

4. (Optional) Make sure that Optimize for restores is checked. This can make backing up
much slower, but it makes restoring faster.

5. Drag the hard drive onto the DropDMG window or use one of the other methods.

The Restoring Files and Disks section describes how to restore your backup.

"http://www.apple.com/macosx/what-is-macosx/time-machine.html
Shttp://support.apple.com/kb/ht1661
“http://wuw.shirt-pocket.com/SuperDuper/
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3.3 Backing Up Your Files to CD/DVD

By combining DropDMG’s imaging and burning features, you can easily back up your files to CD-
R/RW, DVD-R/RW, or Blu-ray. DropDMG will store the files efficiently on the discs, and you can
optionally protect them using encryption.

1. Go to the Configurations tab of DropDMG’s Preferences window and click the 4+ button
to make a new configuration. Set the options that you want to use for the backup.
Probably you’ll want one of the compressed .dmg formats. For an encrypted backup,
choose an encryption level and set a passphrase. Use the Sizes pop-down menu to set
the size of the segments to match the discs you’ll be using. If you will be backing up
an entire disk, make sure that Optimize for restores is checked.

Note: Since you created a new configuration, you can skip this step next time; just
make sure that the proper configuration is selected.

2. To back up a folder, drag it onto the DropDMG window or use one of the other methods.
DropDMG will create a .dmg and (if necessary) some .dmgpart files.

3. Use the Burn... command to burn the .dmg and .dmgpart files to disc, making sure
that it’s set to Burn disk images as files.

4. After the burning is complete, you can delete the .dmg and .dmgpart files.

This backup method has a variety of advantages over ultra-simple backup methods (e.g. Burn
Folders in the Finder) and more specialized backup programs:

e Collecting the files onto a .dmg file is better than burning the files directly:

— The .dmg file can be compressed (to save space) and encrypted (to keep your off-site
backup private).

— The .dmg file has an internal checksum. When you mount the disk image or use
DropDMG’s Verify Image. .. command, Mac OS X verifies that the backup disc is not
damaged. This lets you ensure that your backup remains valid and that the files can be
restored correctly.

— You can easily backup large files that don’t fit on a single CD or DVD because DropDMG
will save them into disc-sized .dmgpart files.

— All file ownership and permissions metadata is preserved.

e Backups created with DropDMG are stored in a standard Mac OS X format. The software
needed to restore them is built into the operating system.

e The two-step process (creating the disk image files and then burning them) saves time. If
you were using software such as Retrospect to back up a large folder, it would prompt you
for discs as it copied the files. Then, when it was done, it would prompt you for all the discs
again to verify them. During this time, you would not be able to modify the files in the folder,

12



because the backup could be corrupted if you modified files that were in the midst of being
copied. Thus, the amount of time that your Mac is “out of commission” is determined by the
time it takes to do the burning and swap all the discs.

With DropDMG, the first step of creating the .dmg files can run unattended, while you’re at
lunch or sleeping. When you get back to your Mac, you can burn the files to disc at your
leisure. Since the folder has already been “snapshotted” to the disk image, you can access and
modify the folder while burning the discs. Furthermore, if you have multiple optical drives
you can save time by burning multiple discs at a time. Since each disc is verified individually,
right after it’s burned, you don’t have to swap the discs twice.

The Restoring Files and Disks section describes how to restore your backup.

3.4

Burning Backups of CDs/DVDs

You can use DropDMG to create exact copies of CDs, DVDs, and Blu-ray discs, for example:

e Your Mac OS X install discs.

e A bootable emergency CD for disk repair software such as DiskWarrior

1 11

0 or Drive Genius!!.

e Video discs that you've created. (In this case, use the .cdr format instead of the .dmg

format.)
To do this:

1. Go to the Configurations tab of DropDMG’s Preferences window and set DropDMG to
create a read-only .dmg image.

2. Drag the CD or DVD icon onto the DropDMG window or use one of the other methods.
DropDMG; it will create a device image of the disc and save it as a .dmg file.

3. Eject the disc.

4. Use the Burn. .. command to burn the .dmg file, making sure that Burn contents of
disk images is selected.

5. DropDMG will ask you to insert a blank disc; after doing so, click the Burn button.

Ohttp://www.alsoft.com/DiskWarrior/
"http://www.prosofteng. com/products/drive_genius_info.php
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Tip: DVDs are faster to access than CDs. If you burn a DVD copy of an emergency boot CD, your
Mac will boot approximately 25% faster from the backup than from the original CD. This can be
a savings of a couple minutes.

3.5 Restoring Files and Disks

Once you’'ve backed up the contents of a hard disk or CD-ROM to a disk image, how can you
restore the files?

If you just need to access specific files

Double-click the .dmg file to mount it, then locate the files using the Finder. If a large disk
image is split into multiple .dmg and .dmgpart files, move or copy them all into a single folder
before trying to mount the .dmg.

Tip: If you have many .dmg files, you can use a utility such as CDFinder'? to catalog them
so that you can easily find which .dmg contains the files that you're looking for.

To restore an entire drive

1. Open the Disk Utility program in the Utilities folder of the Applications folder.

Tip: You can also access Disk Utility by booting from your Mac OS X installation
CD/DVD or Lion recovery partition!?; that way, you can restore your drive without
first having to install Mac OS X.

2. Choose Scan Image for Restore. .. from Disk Utility’s Images menu and select
the disk image file. If you used DropDMG’s Optimize for restores option when
creating the backup, you can skip this step.

3. Select the target drive in the list at the left side of the main Disk Utility window.

4. Click on the Restore tab. Drag the image file onto the Source field, and then
drag the target disk from the list to the Destination field.

5. When you click the Restore button, Disk Utility will erase the target drive and
replace its contents with an exact copy of the drive that the image was created
from. If the original drive was bootable, the restored drive will be, too.

To restore an entire CD or DVD

Choose Burn. .. from the File menu and select the disk image file. Make sure that Burn
contents of disk images is selected. This lets you create a copy of the original disc.
3.6 Making Images With Background Pictures

1. Go to the Layouts tab of DropDMG’s Preferences window and create a new layout by
clicking the 4+ button. Configure the background image and icon positions in the layout.

2http://waw. cdfinder.de
Bhttp://www.apple.com/macosx/recovery/
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2. Go to the Configurations tab of DropDMG’s Preferences window, pick one of the .dmg
formats, and select your new layout form the Layout pop-up menu.

3. Drag your source folder onto the DropDMG window or use one of the other methods.
DropDMG will create a .dmg file using the view options that you specified in the layout.

3.7 Protecting Your Files With Encryption

Apple’s FileVault'* encrypts your whole hard drive (Mac OS X 10.7) or home folder (Mac OS X
10.6 and earlier). This is overkill for many users, needlessly slowing access to files and increasing
the risk of data corruption. Additionally, whole drive encryption does not secure your files from
other user accounts on the same Mac.

DropDMG lets you use the same encryption technology to protect a select group of files from prying
eyes. Each group of files is stored on an encrypted disk image. Each disk image can hold as many
or as few files as you want and can have its own passphrase. The files will be secure if your hard
drive is stolen or if you send the disk image across a network. The files will be searchable via
Spotlight after you’ve entered the passphrase.

To create an encrypted disk image

Choose New Blank Disk Image. .. from the File menu. Set an encryption level and passphrase.
A white volume icon will appear in the Finder. You can move existing files onto the disk
image or create new ones there.

To lock your encrypted files

Click the eject button next to the white volume icon in the Finder’s sidebar.

To access your encrypted files

Double-click the disk image file. Mac OS X will ask for the passphrase, and it can optionally
remember it in the keychain. DropDMG’s Mount Image... command provides additional
options.

Tip: You can save time by creating a Login Item to make some encrypted files available whenever
you log into your Mac. Choose System Preferences. .. from the Apple menu. Click on Accounts,
and then select your account. Then click Login Items. Drag your .dmg file into the list. Now,
whenever you log into your Mac, it will mount the disk image.

Tip: If you copied existing files to the encrypted disk image, you may want to remove any traces of
the unencrypted files from your drive. To do this, put the originals in the trash and choose Finder
> Secure Empty Trash... or use the Erase Free Space. .. button in Disk Utility.

Yhttp://docs. info.apple.com/article.html?path=Mac/10.6/en/8727 .html
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3.8 Transferring Files Securely

You can use DropDMG to transfer files from one Mac to another, while protecting them from
unauthorized access.

1. Put the files in a folder.

2. Go to the Configurations tab of DropDMG’s Preferences window and set DropDMG to
create a compressed .dmg image that’s encrypted with a passphrase.

3. Drag your folder onto DropDMG. This will create an encrypted .dmg file.

4. You can then send this file via e-mail, upload it to an iDisk or FTP server, or transfer
it physically (via a flash drive, hard disk, CD, etc.) without worrying about anyone
accessing its contents.

5. An authorized person can access the files by double-clicking the .dmg file and entering
the passphrase.

3.9 Sharing Licenses and Layouts

DropDMG automatically saves licenses and layouts in its folder in Application Support. You
may, however, wish to share your licenses and layouts with other users. This is especially useful if
you want to keep them under a version control system such as Subversion'® or Git!6.

To export a license, drag it from the source list to the Finder. This will create a folder containing
a .plist file and a .rtf file for each language.

To export a layout, drag it from the source list to the Finder. This will create a folder containing
an Info.plist, the background image file, etc.

When creating a disk image using the dropdmg command-line tool, you can specify detached li-
censes or layouts using the -—-license-folder and --layout-folder parameters. Corresponding
parameters are available for AppleScript.

3.10 Burning a Lion Installation DVD

If you’ve purchased Mac OS X 10.7 Lion from the Mac App Store, it’s useful to make an installation
disc in case your hard drive becomes damaged and you need to repair it or reinstall Mac OS X.
Just follow these steps:

http://subversion.tigris.org
phttp://git-scm.com
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1. Choose Burn. .. from DropDMG’s File menu.

2. In the Applications folder, double-click Install Mac 0S X Lion.app to open it.
Then open the SharedSupport folder and select the InstallESD.dng file.

3. Make sure that Burn contents of disk images is selected and click the Choose
button.

4. Insert a blank DVD and click the Burn button.

4 Menus

4.1 The DropDMG Menu
4.1.1 About DropDMG

The About DropDMG window shows the credits, as well as download and support information.
You can always download the latest version of DropDMG from the DropDMG Web site!7.

Questions about DropDMG may be sent to dropdmg@c-command.com'®. We're always looking to
improve DropDMG, so please feel free to send any feature requests to that address.

To make sure that you have the latest version of DropDMG, you can use the Software Update. . .
command.

4.1.2 Software Update...

Click the Check Now button, and DropDMG will tell you whether a newer version is available for
download. By default, DropDMG will automatically check for new versions each time it is launched
and once per day. You can disable this feature by unchecking the checkbox.

If a new version is available, DropDMG will tell you what’s new in that version. Click Download
to have DropDMG download the .dmg file for the new version to your Internet downloads folder.
(You can change the folder in Safari’s preferences.) Click Download & Install to have it download
the .dmg and then update the installed DropDMG application to the new version.

To check for a new version, DropDMG contacts a Web server at c-command.com. DropDMG
transmits the following information to the server: the name of the product (DropDMG) and its
version, the version of Mac OS X, the kind of processor that the Mac has, whether DropDMG has

"http://c-command. com/dropdmg/
Bhailto: dropdmg@c-command. com

17


http://c-command.com/dropdmg/
mailto:dropdmg@c-command.com

been purchased, and the name of the current language. This information is used to guide future
development. No personal information is transmitted.

Note: The Software Update. .. menu command is not present if you purchased via the Mac App
Store. Updates are available via the App Store application.

4.1.3 Purchase...

This window lets you buy DropDMG. If you've already purchased DropDMG but it’s running in
demo mode, you can you enter your name and serial number to personalize your copy of DropDMG
and remove the demo limitations.

DropDMG has a free trial period that lasts for 30 days or 7 launches, whichever is longer. To use
DropDMG beyond the demo period, you must purchase it. This entitles you to free updates and
support.

To purchase, choose Purchase. .. from the DropDMG menu. You can use the Purchase Online
button to enter the online store.

Soon after paying, you’ll receive an e-mail with your serial number. Enter the name and serial
number from the e-mail into the Purchase window and click Personalize. If you need to re-
install DropDMG, you can simply re-enter your name and serial number and click Personalize;
there’s no need to purchase again.

If you purchased DropDMG but cannot find your serial number, click the Look Up My Serial
Number button. This will open a form where you can enter your e-mail address and look up your
order information.

A license for DropDMG is good for one person or one computer. You can install it on one Mac,
and everyone sharing that Mac can use it (on that Mac). Alternatively, you can install it on your
desktop Mac and your laptop; you can then use it on either machine, provided that no one is using
it on the other machine.

Note: The Purchase. .. menu command is not present if you purchased via the Mac App Store.
In that case, there is no trial period, and licensing is based on your iTunes account rather than the
number of people or computers.

4.2 The File Menu

4.2.1 New from Folder/File...

When you choose New from Folder/File. .. from the File menu, DropDMG brings up a window
where you can select a source file or folder. Hold down the Command or Shift key to select multiple
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source items. For each source item, DropDMG will create a new disk image or archive, using the
options from the selected configuration.

You can also choose a volume (e.g. a hard drive or optical disk) as the source for creating a disk
image. In this case, DropDMG will create a special device image that is an exact copy of the source
volume and its filesystem.

A shortcut for New from Folder/File... is to drag the source folder or file onto the DropDMG
window or DropDMG’s Dock icon.

LOLO) MNew from Folder/File

lI]]]][lﬁ__lDemu ':] Q

DEVICES Name 4| Date Modified
K icarus
L Aux

£ Time Machine ...

|

|

PLACES
SEARCH FOR

MEDIA

ﬁ Music

|=| Photos

ﬁ Movies

Configuration: | 1 Zip

ar
L1

Fe X p )
[ Cancel ) Choose
| R

4.2.2 New Blank Disk Image...

This creates an empty disk image with the specified format and size and mounts it in the Finder.
The blank disk image acts as a virtual disk. Applications can directly read and write to files stored
on the disk image, but the files disappear when you eject the disk image. Double-click the disk
image file to make its contents accessible again.
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By setting the disk image to be encrypted, your virtual disk can act as a mini FileVault. When
using FileVault!?, your entire drive (Mac OS X 10.7) or home folder (Mac OS X 10.6 and earlier)
is encrypted. This is slow, makes your data more susceptible to corruption, and (on Mac OS X
10.6 and earlier) limits the ability to back up and recover files using Time Machine?®. Disk images
created by DropDMG use the same encryption technology as FileVault, and they avoid FileVault’s
drawbacks by only encrypting the files that you choose.

Image Format

Blank disk images can be created in .dmg, .sparseimage, and .sparsebundle formats. For
more information, see Format section.

Encryption

The encryption can be None, 128-bit AES, or 256-bit AES. For more information on the
encryption types, see the Encryption section. You can use the From Configuration pop-
down menu to quickly enter a passphrase saved in the keychain.

Volume Size

This is the maximum capacity of the blank disk image. For .dmg files, this is also how much
space the disk image will take up. Sparse disk images will consume less disk space, depending
on how much of the capacity you use.

Volume Name

The name of the virtual disk, as shown in the Devices section of the Finder’s sidebar. This
need not necessarily be the same as the name of the disk image file, which is set in the Save
As field.

http://docs. info.apple.com/article.html?path=Mac/10.6/en/8727 .html
2Ohttp://www.apple.com/macosx/what-is-macosx/time-machine.html
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el n MNew Blank Disk Ima.ge

Save As: My Mini FileVault E]
([« » ] (22 =4 @) (& Demo Y (Q )
DEVICES MName 4| Date Modified
B icarus

|

| Aux

@, Time Machi... =

PLACES T
Image Format: ' Sparse Bundle disk image (most efficient) I :]
Encryption: 'L 256-hit AES encryption (more secure, but slower) | H
[:Set Fassphrase...j = [ From Configuration rv-i
Volume Size: 1,000 ME ' Sizes rv-}
Volume Name: |Automatic, based on filename {T_':l
New Folder I': Cancel :I E Save 3

A

4.2.3 Convert Image/Archive. ..

When you choose Convert Image/Archive. .. from the File menu, DropDMG brings up a window
where you can select a source disk image or archive. Hold down the Command or Shift key to select
multiple source items. DropDMG will convert each source item into a new disk image or archive,
using the options from the selected configuration.

You can use Convert Image/Archive. .. to join a segmented disk image (a .dmg file and multiple
.dmgpart files) into a single .dmg file. Select the desired format in the preferences, and make sure
that Limit segments to is unchecked. Then tell DropDMG to convert the source .dmg file.

A shortcut for Convert Image/Archive... is to drag the source disk image or archive onto the
DropDMG window or DropDMG’s Dock icon.
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4.2.4 Compact Image...

Sparse disk images, created for example using the New Blank Disk Image. .. command, grow in size
when you add files to them. When you remove files from them and empty the trash, the space is
available for adding more files, but it is still “reserved” for use by the disk image. Thus, the size of
the disk image file does not automatically decrease. The Compact Image... command lets you
reclaim the unused space, thus shrinking the disk image file.

Depending on how fragmented the contents of the sparse disk image are, it may not be possible to
reclaim all of the unused space. (It may help to use a defragmentation utility such as iDefrag?! or
Drive Genius?2.) To shrink your sparse disk image to the minimum possible size, use the Convert
Image/Archive. .. command to create a fresh file.

You can hold down the Command or Shift key to select multiple files for compacting.

4.2.5 Change Image Passphrase. ..

This command lets you change the passphrase of an encrypted disk image. This is a fast operation
that does not require copying the whole file or use lots of temporary disk space. To change the
passphrase and the format, use the Convert Image/Archive. .. command.

You can hold down the Command or Shift key to change the passphrases of multiple images at
once.

4.2.6 Get Image Info...

This command lets you get information about a disk image, such as its format, information about
its partitions, how much data it contains, and the effectiveness of the compression.

You can hold down the Command or Shift key to get information about multiple disk images at
once. The Enter Passphrase. .. button lets you specify the passphrase for reading an encrypted

2'mttp://www.coriolis-systems.com/iDefrag. php
nttp: //www.prosofteng. com/products/drive_genius.php
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disk image. The From Configuration pop-down menu lets you use a passphrase that’s

your keychain as part of a configuration.

A Non _| Info for “SpamSieve-2.8.2.dmg"

stored in

w Backing Store Information
¥ Backing Store Information
Class Name
MName
URL
Class Name
Mame
URL
Checksum Type
Checksum Value
Class Name
Format
Format Description
b Partition Information
P partitions
¥ Properties
Checksummed
Compressed
Encrypted
Kernel Compatible
Partitioned
Software License Agreement
- Segments
W Size Information
Compressed Bytes
Compressed Ratio
CUDIFEncoding-bytes-in-use
CUDIFEncoding-bytes-total
CUDIFEncoding-bytes-wasted
Sector Count
Total Bytes
Total Empty Bytes
Total Non-Empty Bytes

udif-ordered-chunks

CEsDBackingstore

SpamSieve-2.8.2.dmg

file:/ /localhost/Users fmjt/ Documents/ Program_ ..
CUDIFEncoding

SpamSieve-2.8.2.dmg

file:/ /localhost/Users fmjt/ Documents/ Program_ ..
CRC32

$95DD7V642

CUDIFDisklmage

UDZ0o

UDIF read-only compressed (zlib)

7,291,650
0.40
7,291,650
7,291,650
0

59,370
30,397,440
12,059,136
18,338,304
1
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4.2.7 Mount Image...

The most straightforward way to mount a disk image is to double-click it. This works on any Mac
OS X installation, even if DropDMG isn’t installed.

DropDMG also provides the Mount Image. .. command in the File menu, for additional options
and convenience.

Verify

Verification ensures that the contents of the disk image are intact, i.e. the file is not damaged.
You can turn off verification to reduce the time it takes to mount the disk image. For more
information on verification, see the Verify Image. .. section.

Enable file ownership

When you mount an image by double-clicking it, Mac OS X treats every file on the mounted
image as though it were owned by you (the current user). When you mount an image using
this option, the files are displayed with their actual owners, as stored on the disk image. Thus,
if you use DropDMG to back up a collection of files whose ownership matters, you should
also use DropDMG to mount the image when you restore from that backup.

Shadow file

This option lets you mount a read-only disk image as read-write. Any changes that you make
are written to a .shadow file so that the original disk image file remains unchanged. One use
for this feature is if you need to use Spotlight to search a read-only disk image. Spotlight
requires write access (even if its index is already up-to-date), but it will work if you mount
the disk image using a shadow file.

Passphrase

When you double-click an encrypted disk image, Mac OS X prompts you for the passphrase.
DropDMG lets you avoid this step, which is particularly handy when bulk-mounting im-
ages with the same passphrase or when mounting segmented disk images. The Enter
Passphrase. .. button lets you specify the passphrase for mounting the disk image. The
From Configuration pop-down menu lets you use a passphrase that’s stored in your key-
chain as part of a configuration.

Location

Normally, disk images are mounted on the desktop. You can also specify some other location
in your local filesystem. This is useful when another application looks for files in a particular
folder. For example, say that you want to encrypt your mail. You could create a New Blank
Disk Image... and then mount it at /Users/<username>/Library/Mail/, and then Apple
Mail will stores its files on that disk image.

One advantage of using DropDMG’s Mount Image... command, rather than double-clicking a
disk image in the Finder, is that DropDMG only makes you enter the passphrase for an encrypted,

24



segmented disk image once. The Finder requires that you type the passphrase once for each segment
or that you store the passphrase in the keychain, which you might not want to do.

Additionally, DropDMG’s Mount Image. .. command will skip the display of any software license
agreements.

You can hold down the Command or Shift key to mount multiple disk images at once using the
same options.

t @

FAVORITES . MName 4 Date Modified
Ei EncryptedMail.dmg September 9, 2011 3:07 PM

DEVICES

Options: g Verify g Enable file ownership [ | Shadow file

Passphrase: [ Enter Passphrase. . ] ﬂ [ From Configuration v]

Location: () Mount on desktop {/Volumes)

(*) Mount at: (i Library = @

[ Cancel ] _
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4.2.8 Verify Image...

()

This command lets you verify that a disk image file is in working order (i.e. that it is not damaged)
before it becomes a serious problem. You can tell DropDMG to verify a folder, and it will find all
the disk images in that folder (and its subfolders) and verify them.

For example, if there is damage to your disk image and a file becomes corrupt, you’ll learn of the
problem as soon as you use the Verify Image. .. command. Without Verify Image. .., you might
only learn of the problem when you tried to access the damaged file on the disk image (perhaps a
long time in the future), and perhaps not even then, because the corruption might not be readily
apparent. Because you learn about the damage early, you can restore a correct version of the file
from a backup, rather than filling your future backups with damaged copies of the file.

The verification works by reading the entire contents of the disk image and calculating a checksum.
This is then compared with the checksum that was stored in the disk image when it was first
created. Because modifying the contents of a disk image would invalidate the checksum, only disk
images in read-only formats can be verified.

You can hold down the Command or Shift key to verify multiple disk images at once. The Enter
Passphrase. .. button lets you specify the passphrase for accessing encrypted disk images. The
From Configuration pop-down menu lets you use a passphrase that’s stored in your keychain as
part of a configuration.

A shortcut for Verify Image. .. is to drag the source disk image onto the DropDMG window or
DropDMG’s Dock icon while holding down the Control key.
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k- PLACES

k- SEARCH FOR

If all of the disk images are encrypted with the same passphrase, you can enter it here.

(_Erlter Passphrase. .. _} [ From Configuration H

(Cam:el) H )
A

4.2.9 Burn...

This command lets you burn files and folders to CD, DVD, or Blu-ray. This requires an internal or
external drive that supports Mac OS X disc burning. You can continue to use DropDMG to create
other disk images or archives while a disc is burning, and if you have multiple optical drives you
can even burn more than one disc at a time.

When you choose to burn a disk image file (rather than a regular file or a folder), you have two
options:

Burn contents of disk images

This makes the contents of the burned disc look like the contents of the disk image. The
volume name of the mounted disk image becomes the name of the disc. If the disk image
is a device image that contains multiple partitions, then the burned disc will have multiple
partitions. This is useful when:

e You want the burned disc to contain the contents of the disk image, not the disk image
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file itself. The contents of the burned disc will not be compressed or encrypted.
e The disk image is segmented, and you want to join the segments and burn them onto a
single disc.
Burn disk images as files
This burns a disc whose content is the single disk image file. The name of the disc is the file’s
name, without the extension. This is useful when:
e You want the burned disc to contain a single file, the disk image. If the disk image file
was compressed or encrypted, so will be the burned file.

e The disk image is segmented, and you want to burn each segment to a different disc.

As a shortcut to choosing Burn... from the File menu, you can hold down the Shift key while
dragging and dropping a folder onto the DropDMG window or DropDMG’s Dock icon. If you want
to burn an disk images as files, hold down the Shift and Option keys.

You can also initiate burns from Terminal:

dropdmg --burn-image ~/Desktop/Image.dmg
dropdmg --burn-file ~/Desktop/Folder

Tip: When burning a CD, check the Leave disc appendable box after inserting the blank disc.
DropDMG will leave the disc “open” after burning so that you can burn additional files to the
same disc under a new session, space permitting.

Tip: To burn a disc with a custom volume icon, first create a disk image using the Custom volume
icon option. Then use DropDMG to burn the disk image file, using the Burn contents of disk
images option.
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Burn Disc In: SuperDrive E]

The disc has 737 MB available; 414 MEB are needed.

Burn Options

Speed: f Maximum Possible (24x) |3 i [ | Test Only

Erase disc before burning
M Leave disc appendable

After Burning
E‘u‘erify burned data
= Eject disc () Mount on Desktop

[ Eject ) I::Canceljl ( Burn :l

4.2.10 Join Files...

Sometimes a large file is split into smaller pieces for easier transfer over the Internet or multiple
CDs/DVDs. This command lets you combine file.001, file.002, file.003, etc. back into a
single file file, provided that all the pieces are in the same folder.

This command is only for use with files created by other software that are named in the above man-

ner. DropDMG’s segments feature creates files such as file.dmg, file.002.dmgpart, file.003.dmgpart,
etc. A segmented disk image can be accessed by double-clicking the .dmg file; it is not necessary

to first join the part files. If you do need to combine a segmented disk image and its parts into a
single .dmg file, use the Convert Image/Archive. .. feature.

As a shortcut for Join Files..., you can drag the .001 file onto the DropDMG window or
DropDMG’s Dock icon.
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4.3 The View Menu
4.3.1 Log Detail

The Show/Hide Log Detail commands control whether the log detail drawer of the DropDMG
window is open. The drawer shows additional information about the selected log entry, such as
what the source and destination files were, how fast the data was copied, how much disk space was
saved, and error information.

DropDMG remembers between launches whether the drawer is open.

A shortcut for Show/Hide Log Detail is to double-click a log entry.

DropDMG

Configuration: [ o Compressed zlib

Drop folders or files here or onto the DropDMG ican.

@ 6/22/104:15 M Create Documents.dma

% 6/22/104:17 PM Compact Archived.sparsebundle

@ B6/22/104:17 PM Verify MacO5XUpdCombol10.6.4.dmg
@ 6/22/104:193 M Convert Documents.zip

© 6/22/104:20 PM Burn Mail 2010-06-20.dmg

v 922711 1:37 PM Test Folder.dmg

Started Thursday, September 22, 2011 1:37:19 PM EDT
Succeeded Thursday, September 22, 2011 1:37:26 PM EDT

Per Second EBG KB
Source Size 410 KE
Destination Size 385 KE
Saved 25 KB
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4.3.2 Show All Log Entries/Errors Only

These commands control whether the log in the DropDMG window shows every log entry (including
successfully completed operations) or just the log entries for operations that failed with an error or

were canceled.

DropDMG

Configuration: [ o Compressed zlib

Drop folders or files here or onto the DropDMG ican.

6/22/10 3:23 PM
6/22/10 4:15 PM
6/22/10 4:17 PM
6/22/10 4:17 PM
6/22/10 4:19 PM
6/22/10 4:20 PM

]
]
]
]
]
@

Info
Create
Compact
Verify
Conwvert
Burn

SpamSieve-2.8.2.dmg
Documents.dmag
Archived.sparsebundle
MacOsXUpdCombo10.6.4.dmg
Documents.zip

Mail 2010-06-20.dmg

4.4 The Window Menu

4.4.1 Activity Window

DropDMG can perform multiple operations at once, simultaneously creating disk images, burning
them, verifying them, etc. This window shows the operations that are currently in progress and
what states they are in. You can cancel an operation by clicking its x button.

DropDMG remembers between launches whether the window is open.

A shortcut for opening the Activity window is to click the progress spinner at the bottom of the

DropDMG window.
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Burning “Mail 2010-06-20.dmg"

A ==

Writing track - About 4 minutes

Creating from “Documents”

Creating disk image - Abowt 5 seconds

4.4.2 DropDMG Window

800 DropDMG

Configuration: [ . Compressed zlib

Drop folders or files here or onto the DropDMG icon.

6f22/10 3:23 PM Info SpamSieve-2.8.2.dmg

B6/22/10 4:15 PM Create Documents.dma

6/22/10 4:17 PM Compact Archived.sparsebundle
6/22/10 4:17 PM Verify MacOsXUpdCombol0.6.4.dmg
6/22/10 4:19 PM Convert Documents.zip

B/22/10 4:20 PM Burn Mail 2010-06-20.dmg
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DropDMG’s main window has five parts:

1. At the top is a toolbar with shortcut buttons for accessing frequently used commands.
You can choose which commands are available by choosing Customize Toolbar. ..
from the View menu.

2. Below the toolbar, a pop-up menu lets you pick one of the configurations. This deter-
mines the options that will be used to create a disk image or archive. Hold down the
Option key while choosing from the pop-up menu to open a configuration for editing.

You can drag files and folders into this area of the window to initiate the following types
of operations: New from Folder/File..., Convert Image/Archive..., Verify Image.. .,
Burn.. ., and Join Files.... DropDMG will automatically figure out what to do, and
you can hold (or not hold) the Option key to specify temporary options that override
the configuration.

3. The log shows a list of the completed operations. The Show All Log Entries/Errors
Only menu commands determine which log entries are shown. You can copy log entries
as text using Edit > Copy or delete them by pressing the Delete key. The Remove log
entries preferences lets you set DropDMG to auto-delete old log entries.

You can Control-click on a log entry to perform an operation on that entry’s file. For
example, if you've just created a .dmg file you could burn it.

4. When DropDMG is busy, the bottom bar tells how many operations are in progress.
You can click the progress spinner to open the Activity window and see more detail.

5. The Log Detail drawer shows additional information about the selected log entry.
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DropDMG

Configuration: [ . Compressed zlib

Drop folders or files here or onto the DropDMG icon.

@ 6/22/10 415 PM Create Documents.dmg

@ 6/22/10 417 PM Compact Archived.sparsebundle

@ 6/22/104:17 PM Werify MacOsXUpdCombol0.6.4.dmg
@ 6/22/10 419 FM Conwvert Documents.zip

@ 6/22/104:20 PM Burn Mail 2010-06-20.dmg

v 922711 1:37 M Test Folder.dmg

L

Started Thursday, September 22, 2011 1:37:19 PM EDT
Succeeded Thursday, September 22, 2011 1:37:26 PM EDT
Per Second 66 KB
Source Size 410 KB

Destination Size 385 KE

Saved 25 KB

DropDMG remembers between launches whether the DropDMG window is open.

5 Preferences

5.1 Configurations

DropDMG provides many options for creating disk images and archives. Configurations let you cre-
ate named sets of these options, so that you can quickly switch between your favorite combinations
rather than re-entering all the settings each time.
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8o Configurations "

@ Compressed bzip2 Format: [ .dmg — smaller file, faster 10.2 #]

@ Compressed zlib

&
@ Encrypted

[
v Encrypted Segments

Encryption: [ 256-bit AES 10.5 t][ Set Passphrase... ]

Segments: ™ Limit file size to | 4,692] MB Sizes v

License: [ None

Layout: [ None

Fa
@ Sparse Bundie Options: || Custom volume icon Set Icon...
m tar.bz2 [ | Internet-enabled

BT

Optimize for restores

@ tar.gz
— Destination: | | Aux

zip Zip Names: [ Automatic

Source: | | Delete after creating
+ | = |ﬂ '| || Delete after converting

Use the + button to create a new configuration and the - button or the Delete key to remove one.
Several commands are available in the action menu and contextual menu:

Make Default
Change the current configuration as shown in the DropDMG window. You can also double-
click on a configuration in the list.

Duplicate Configuration

Create a new configuration with the same options as the selected one.

Rename Configuration

Change the name of the selected configuration. You can also click-and-hold on the name or
press the Return or Enter key.

Tip: You can quickly change configurations, without first opening the Preferences window, by using
the pop-up menu in the DropDMG window, by Control-clicking on DropDMG’s icon in the Dock,
or by using Temporary options.

The following options are available for each configuration:
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5.1.1 Format

DropDMG supports the following disk image and archive formats:

Read-only Disk Image

The contents of a read-only disk image can be directly accessed from the Finder, but they
cannot be modified. Read-only disk images support licenses. They have internal checksums
for use with the Verify Image... command. In order to search a read-only disk image via
Spotlight, use the Mount Image. .. command and select the Shadow file option.

.dmg — smaller file, faster
A disk image compressed using zlib?3. The file is relatively compact and quick to access.
This is DropDMG’s recommended format for general use. DropDMG creates smaller
zlib-compressed disk images than Disk Utility. Compatible with Mac OS X 10.2 and
later.

.dmg — smallest file, slower
A disk image compressed using bzip2?. Depending on the type of data stored, this can
be significantly smaller than a zlib-compressed disk image. It is also slower to create
and access. Compatible with Mac OS X 10.4 and later.

.dmg — no compression
An uncompressed disk image will always be larger than a compressed one. However,
with certain types of content (music, photos, already compressed files) the difference in
size will be slight, and an uncompressed disk image will generally be faster to create and
access. Compatible with Mac OS X 10.2 and later.

Read-write Disk Image

The contents of a read-write disk image can be directly accessed from the Finder, and you
can add, remove, and modify files. Read-write disk images can be created from existing
files/folders or by using the New Blank Disk Image. .. command.

.sparsebundle — most efficient

Sparse bundle disk images appear as a single file but are actually stored as a folder with
many files inside. This makes it more efficient to back them up using Time Machine or
other backup utilities, as only the changed parts need to be copied. Additionally, sparse
bundle disk images work well with the Compact Image. .. command. Compatible with
Mac OS X 10.5 and later.

.sparseimage — more efficient
Sparse disk images are stored as a single file. This can make backups inefficient for large
disk images, because the entire file must be copied each time. The Compact Image. ..
command generally does not reclaim as much disk space as with sparse bundle disk
images. Compatible with Mac OS X 10.3 and later.

nttp://en.wikipedia.org/wiki/Z1lib
?http://en.wikipedia.org/wiki/Bzip2
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.dmg — constant file size
The disk image is stored as a single file. This is less efficient than a sparse disk image
because the file size is determined by the capacity of the disk image rather than by the
amount of data currently stored on it. This can be desirable, for example if you want to

reserve a certain amount of space for the disk image’s use. Compatible with Mac OS X
10.2 and later.

Cross-platform Archive

Archives make your files accessible to computers running other operating systems (Windows,
Linux, etc.). Archives are slower and require more disk space than disk images, as they must
first be expanded before the contents are accessible in the Finder. DropDMG creates special
archives that preserve resource forks and Mac metadata. This extra information is ignored
by other operating systems.

.tar.gz — smaller file, faster

A tape archive, compressed using gzip?®. The file is relatively compact and quick to
create and expand. Compatible with Mac OS X 10.4 and later.

.tar.bz2 — smaller file, faster

A tape archive, compressed using bzip226. Depending on the type of data stored, this can
be significantly smaller than a .tar.gz archive. It is also slower to create and expand.
Compatible with Mac OS X 10.4 and later.

.tar — no compression

An uncompressed archive will always be larger than a compressed one. However, with
certain types of content (music, photos, already compressed files) the difference in size
will be slight, and an uncompressed archive will generally be faster to create and expand.
Compatible with Mac OS X 10.4 and later.

.zip — smaller file, faster

A ZIP archive is similar to a .tar.gz archive except that this format is more common
on Windows. DropDMG creates smaller ZIP archives than the Finder. ZIP archives do
not preserve creation dates or Unix ownership. Compatible with Mac OS X 10.3 and
later.

Cross-platform Disk Image

.cdr DVD/CD-R Master

A master disk image is an uncompressed, read-only disk image. If created from a file
or folder, it will have a Mac filesystem; if created from a volume, the filesystem will be
unchanged. This is mainly useful for imaging an existing volume (e.g. copying a CD,
DVD, or Blu-ray disc) or creating a Mac disk image to burn using a non-Mac computer.
Compatible with Mac OS X 10.0 and later.

.iso Hybrid (HFS+, ISO 9660, Joliet, UDF)

*http://en.wikipedia.org/wiki/Gzip
2nttp://en.wikipedia.org/wiki/Bzip2
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A hybrid disk image is like a master. Additionally, the image contains multiple filesys-
tems so that the contents may be accessed using any operating system. Compatible with
Mac OS X 10.0 and later.

Legacy NDIF Disk Image

NDIF disk images are compatible with System 7, Mac OS 8-9, and Mac OS X. These can be
useful for exchanging files with legacy Macs or for use with emulators such as Sheepshaver?”
and Basilisk?®. NDIF disk image files use resource forks, so some care must be taken in
transferring them over the Internet. They are also limited to 2 GB of logical size.

.img NDIF-compressed
A compressed, read-only disk image.

.img NDIF read-only
An uncompressed, read-only disk image.

.img NDIF read-write
A disk image whose contents can be modified.

5.1.2 Encryption

Encrypted images require a passphrase for access; the image contents are secure from anyone who
doesn’t know the passphrase. DropDMG uses Apple’s implementation of the Advanced Encryption
Standard (AES)?Y algorithm. Two different strengths of encryption are available:

Mone 10.2
128-bit AES 10.3

v 256-bit AES 10.5

128-bit AES — faster, recommended
The U.S. National Security Agency (NSA) has announced that it may be used for SECRET
level documents. Compatible with Mac OS X 10.3 and later.

256-bit AES — more secure

The NSA has announced that it may be used for TOP SECRET level documents. Compatible
with Mac OS X 10.5 and later.

2"http://sheepshaver.cebix.net
2http://basilisk.cebix.net
nttp://en.wikipedia.org/wiki/Advanced_Encryption_Standard
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Click the Set Passphrase. .. button to choose the passphrase that you want to use. To make sure
that you've typed what you meant to type, you must enter the same passphrase twice.

You can click the Set Passphrase... and then Show Passphrase to verify that the passphrase
is what you intended.

DropDMG stores the passphrase securely in the system keychain. If you prefer DropDMG to
prompt you for a passphrase each time you create a disk image, leave the passphrase blank.

5.1.3 Segments

DropDMG lets you split large disk images into multiple pieces, to keep the size of each file below a
set limit. This can be useful for transferring large files over the Internet or burning them to disc.

To access the contents of a segmented disk image, make sure the .dmg file and all the .dmgpart
files are in the same folder. Then double-click the .dmg file or use DropDMG’s Mount Image. ..
command.

Sizes are specified in megabytes (base 10). The Sizes pop-down menu lets you enter common
segment sizes for CDs, DVDs, and Blu-ray discs. The sizes are chosen so that a segment of that
size can be burned to the disc as a file. The actual disc capacities may vary slightly, as will the
sizes of the segments produced by the disk imaging engine.

679 MB (CD-R)

4.7 GB (DVD-R/DVD+R)
8.5 GB (DVD+R DL)
25.0 GB (BD-R)

50.0 GB (BD-R DL)

To split an existing disk image into smaller pieces, set the segment size and then use the Convert
Image/Archive. .. command.

To join multiple segments into a single disk image file, make sure that all the segments are in the
same folder, uncheck Limit segments to ___ MB, and then use the Convert Image/Archive. ..
command.
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5.1.4 License

If you select a license agreement, Mac OS X will display it each time the user tries to mount your
disk image. The contents of the disk image will only be accessible if the user clicks the Agree
button.

Disk Image With License.dmg

If you agree with the terms [ : [
of this license, press “Agree” English ]
to install the software. If Yo SOﬂware License Agreement
do not agree, press

Disagres,. This software is provided by the copyright holders and contributors “as
is” and any express or implied warranties, including, but not limited to,
the implied warranties of merchantability and fitness for a particular
purpose are disclaimed. In no event shall the copyright owner or
contributors be liable for any direct, indirect, incidental, special,
exemplary, or consequential damages (including, but not limited to,
procurement of substitute goods or services; loss of use, data, or profits;
or business interruption) however caused and on any theory of liability,
whether in contract, strict liability, or tort (including negligence or
otherwise) arising in any way out of the use of this software, even if
advised of the possibility of such damage.

You can create license agreements using the Licenses tab of the Preferences window. In order to
be able to choose a license, it must contain at least one language.

When converting, DropDMG adds or removes license agreements from the source image so that
they match the one chosen here.

Tip: Hold down the Option key when choosing a license to open it for editing.
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5.1.5 Layout

If you select a layout, DropDMG will use it to set the view options, background picture, and icon
positions of the mounted disk image.

You can create layouts using the Layouts tab of the Preferences window.
DropDMG ignores the Layout option when creating a disk image by converting.

Tip: Hold down the Option key when choosing a layout to open it for editing.

5.1.6 Custom volume icon

Normally when a disk image is mounted, it shows up on the desktop with a plain white icon that
looks like a hard drive. With this option checked, DropDMG will customize the icon in one of two
modes:

Automatic

If the top level of the image contains an application, DropDMG will badge the application’s
icon onto the white drive icon. Or, if the disk image contains a single file, DropDMG will
badge that file’s icon onto the drive. DropDMG renders an optimized version of the badged
icon for each size up to 512x512.

Manual

To choose your own graphic file to use as the icon, click the Set Icon... button. Select the
graphic file and click Choose. Then select the source folder and click Choose. DropDMG
will convert your graphic file into an invisible .VolumeIcon.icns in the source folder. Now,
whenever you create a disk image from that source folder (provided that Custom volume
icon is checked) DropDMG will use the .icns file to set the volume icon.

DropDMG ignores the Custom volume icon option when creating a disk image by converting.
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5.1.7 Internet-enabled

When an Internet-enabled disk image is downloaded by Safari (and Safari’s Open “safe” files
after downloading preference is checked), it is automatically expanded®® into a folder and the
disk image file is moved to the trash.

If the disk image has a background picture, it is not transferred to the expanded folder.

Note: Safari under Mac OS X 10.7 does not seem to honor the Internet-enabled setting, although
there has been no indication from Apple that the feature has been removed.

Note: On Mac OS X 10.2.2 through 10.2.8, this also happens whenever an Internet-enabled disk
image is mounted (by any program). On earlier versions of Mac OS X, Internet-enabled disk images
are treated just like other disk images.

5.1.8 Optimize for restores

This option is for when you plan to use Apple Software Restore or Disk Utility to copy the contents
of the disk image back to a hard drive. (See, for example, the Making a Bootable Device Image of
a Hard Drive section.) DropDMG performs an extra pass over the disk image, rewriting the file to
provide the best performance when restoring.

5.1.9 Destination

You can choose to have disk images created in the same folder as the source folder (Next to
Source), or specify a folder where images should be saved (by choosing Other... or dragging a
folder onto the preferences window). The Ask Later option causes DropDMG to ask you, for each
operation, where to save the disk image or archive.

If the destination folder that you specify ends up being invalid (e.g. you specify a destination folder
that’s contained by the source folder), DropDMG will revert to its default behavior of Next to
Source.

The bottom portion of the pop-up menu lists recent folders and favorite folders. Recent folders are
the last 10 folders that you’'ve chosen. Favorite folders are always shown in the menu, even if you
have not used them recently. To make a recent folder into a favorite folder, find the folder’s alias
in the folder:

/Users/<username>/Library/Application Support/DropDMG/Recent Folders

or:

3%nttp://developer.apple.com/documentation/DeveloperTools/Conceptual /SoftwareDistribution/index.html
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/Users/<username>/Library/Containers/com.c-command.DropDMG/Data/Library/Application Support/Dr

(To open the Library folder under Mac OS X 10.7 Lion, go to the Go menu in the Finder and
hold down the Option key.) Select the alias and open the Finder’'s Get Info window. Then click
the Locked checkbox.

5.1.10 Names

This option controls the names of the output disk image or archive and also the mounted disk
image volume.

¥ Automatic

Ask

LIDTIons
Append current date
Sanitize for servers

Automatic

DropDMG chooses the filename and volume name based on the name of the source.

Ask

DropDMG asks you to enter the name of the image file it will create and the name of the
volume that will appear on the desktop when you mount the image. DropDMG will auto-
matically add the proper filename extension to the filename. It may also truncate the names
you enter if they would be too long for the Mac’s volume and filename limits.

Note: The volume name is not settable when creating a device image, although you can use
the CreateDeviceImages esoteric preference to tell DropDMG not to create device images.

Two additional options are available:

Append current date

Add the current date (in YYYY-MM-DD format) to the end of the filename and volume name.
This option is ignored when creating a disk image by converting.
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Sanitize for servers

Process the name of the output file so that it does not contain any spaces, accented or foreign
characters, or certain punctuation marks. This makes it possible to upload it to a Web or
FTP server and then access it using a URL that contains no percent escape sequences.

5.1.11 Delete after creating/converting

If you select one of these options, DropDMG will move the source folder, image, or archive to the
trash after it has finished making the disk image. If an error occurs while creating the output file,
DropDMG leaves the source untouched.

5.2 Licenses

Disk images can include license agreements®! (also known as End-User License Agreements or
EULAS), which are displayed to the user whenever the disk image is mounted. The contents of the
disk image will only be accessible if the user accepts the terms of your license. DropDMG lets you
define multiple license agreements ahead of time. Each agreement may be localized into multiple
languages. You can choose which agreement (if any) to include with each disk image.

Use the + button to create a new license and the - button or the Delete key to remove a license or
language. Several commands are available in the action menu and contextual menu:

New License

Create a new, empty license.

Duplicate License

Create a new license with the same languages as the selected one.

Rename License
Change the name of the selected license. You can also click-and-hold on the name or press
the Return or Enter key.

New Language

Add a language to the selected license. The following languages are available: Arabic, Chinese
(China/Simplified), Chinese (Taiwan/Traditional), Czech, Danish, Dutch, English, Finnish,
French, German, Greek, Hungarian, Italian, Japanese, Korean, Norwegian, Polish, Portuguese
(Brazil), Russian, Slovak, Spanish, Swedish, Turkish, Ukrainian.

A language consists of three elements:

3nttp://en.wikipedia.org/wiki/Software_license_agreement
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Prompt

Mac OS X displays these instructions above your license agreement. It is typically something
like:

If you agree with the terms of this license, press “Agree” to install the software. If
you do not agree, press “Disagree”.

License Text

This is your localized license agreement. The width of the editor pane matches the width of
the pane that Mac OS X uses to display the license to the end user.

The Edit menu contains various helpful commands: Find, Replace, spelling and grammar,
etc.

The Font menu and the Fonts and Colors buttons allow you to customize the appearance
of your license. License agreements can use multiple fonts, sizes, and styles of text.

You can also edit the license text in another application such as TextEdit. To do this, double-
click the language in the source list or drag it onto the TextEdit icon in the Dock. This can
be useful if you want to see multiple languages side-by-side in different windows.

Note: Beware of using fonts that are not built into Mac OS X, for the license agreement will
look different if the user does not have the fonts installed. Secondly, note that “synthetic”
font traits will not be preserved. A synthetic trait is a style for which you do not have a font.
For instance, Mac OS X ships with normal and bold variants of Lucida. Both of these work
fine in license agreements. DropDMG will also let you create a license agreement using italic
Lucida, where the operating system synthesizes Lucida Italic from regular Lucida, but the
italic style will not be displayed to the end user.

Buttons

This lets you customize the names of the Print, Save. .., Disagree, and Agree buttons.

DropDMG automatically saves the licenses that you create. You can also create copies of the
licenses outside DropDMG, as described in the Sharing Licenses and Layouts section.

Note: Due to limitations of the .dmg format, images containing an extremely large number of files
cannot have license agreements.
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806 Licenses e

‘FD] My License If you agree with the terms of this license, press 1 g i
ES English “Agree” to install the software. If you do not agree,
French press “Disagree”. Fonie Colors

German
v|_|| Other

Chinese (China) This software is provided by the copyright holders and contributors “as
: . is” and any express or implied warranties, including, but not limited to,
Chinese (Tafwan) the irr||::|ielz|ir w}gll'ranties of Ener(hantability and fimeag; for a particular
Czech purpose are disclaimed. In no event shall the copyright owner or
Danish contributors be liable for any direct, indirect, incidental, special,
Dutch exemplary, or consequential damages (including, but not limited to,
procurement of substitute goods or services; loss of use, data, or profits:
English or business interruption) however caused and on any theory of liability,
Finnish whether in contract, strict liability, or tort (including negligence or
Erench otherwise) arising in any way out of the use of this software, even if
advised of the possibility of such damage.

Software License Agreement

L~
+ | - |"l '| Print | |Save... | |Disagree | |Agree
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Disk Image With License.dmg

If you agree with the terms
of this license, press “Agree”
to install the software. If you
do not agree, press
“Disagree”.

"English 9

Software License Agreement

This software is provided by the copyright holders and contributors “as
is” and any express or implied warranties, including, but not limited to,
the implied warranties of merchantability and fitness for a particular
purpose are disclaimed. In no event shall the copyright owner or
contributors be liable for any direct, indirect, incidental, special,
exemplary, or consequential damages (including, but not limited to,
procurement of substitute goods or services: loss of use, data, or profits:
or business interruption) however caused and on any theory of liability,
whether in contract, strict liability, or tort (including negligence or
otherwise) arising in any way out of the use of this software, even if
advised of the possibility of such damage.

-y
"

{ Print. ) [ Save... :' 'i Disagree :' ( Agree

5.3 Layouts

When you double-click a disk image, Mac OS X mounts it and opens a Finder window showing its
top-level contents. Layouts let you control the appearance of this window: the window position,
background picture, view options, and icon positions. Additionally, when you create a disk image
with a layout, DropDMG sets it to automatically open the window when mounting the image or

inserting a disc burned from the image.

Use the + button to create a new layout and the - button or the Delete key to remove one. Several

commands are available in the action menu and contextual menu:

Duplicate Layout

Create a new layout that matches the selected one.

Rename Layout

Change the name of the selected layout. You can also click-and-hold on the name or press

the Return or Enter key.
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The middle portion of the window shows a preview of the selected layout. You can drag and drop
to rearrange the icons. By default, DropDMG uses a 16x16 grid so that the icons are aligned with
one another. To drag an icon to any position, unconstrained by the grid, hold down the Command
key. You can also move the selected icons one pixel at a time by pressing the arrow keys.

It is common for a disk image to contain a link to the user’s Applications folder. This makes
it possible to install an application by dragging its icon onto the Applications icon in the same
window. To create this type of link, drag your Applications folder into the layout. The name
will appear in oblique text. When you create a disk image using the layout, DropDMG will
automatically add a symlink to the Applications folder.

Window position

This controls the position of the upper left corner of the window, relative to the upper left
corner of the user’s main display (i.e. the Apple menu).

Background image

Set the background image by dragging an image file onto the well or by clicking the Choose. ..
button. The background image determines the size of the layout. If you do not specify a
background image, DropDMG uses a plain white background with dimensions 640x480.

Note: It is recommended that you design your background image such that it looks good if
the bottom 43 pixels are hidden. This is because Mac OS X does not allow the disk image to
control whether the window’s status bar (20 pixels) or path bar (23 pixels) are shown, and the
bars consume space that would otherwise be available for the window’s content. DropDMG
sets the window size such that, if the user has the bars turned off, the Finder will show the
full background image; if both the bars are turned on, the Finder will show all but the bottom
43 pixels.

Tip: Use a background picture that’s 72x 72 dpi to ensure that the icon positions in DropDMG
and the Finder line up.
Text boxes

Click Add Text to create text boxes that are drawn atop the background image. Click once
on a text box to resize it. Double-click to edit its contents. After selecting some text, you
can use the Fonts panel to set the font, style, color, and shadow. The ruler lets save favorite
styles and adjust the spacing and alignment (left, center, full, or right) of the text.
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The Variables pop-down menu lets you add placeholders that DropDMG will fill in when you
build the disk image, so that you don’t have to manually update the text in your layout. The
supported variables are Application Name (e.g. DropDMG), Application Short Version
String (the marketing version from CFBundleShortVersionString), Application Version
(the build number from CFBundleVersion), and Date (YYYY-MM-DD) (e.g. the date
the disk image was created).

positions
To add an icon to the layout, drag and drop a file or folder or click the Add Icon... button.
The files/folders that you choose here are only used for the purposes of designing the layout,

i.e. specifying where each icon goes. The actual contents of the disk image are determined
by which source folder you drag onto DropDMG.

Tip: This makes it possible to reuse layouts in some interesting ways. For example, you can
use the same layout to create disk images with different contents. The layout can contain
more icons than are present in any given source folder.

size

The icons can be displayed at 16x16, 32x32, 48x48, 64x64, or 128 x128.

Text size

The text size can vary from 10 to 16 point.

DropDMG automatically saves the layouts that you create. You can also create copies of the layouts
outside DropDMG, as described in the Sharing Licenses and Layouts section.
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Note: With the Mac OS X 10.6 Finder, Apple changed the file format that it uses to save a folder’s
view options. Previous versions of Mac OS X do not know how to fully read the new format. This
means that disk images created on Mac OS X 10.6 (using either the Finder or DropDMG) may not
appear exactly as intended when using Mac OS X 10.4 or 10.5. To deploy a disk image for previous
versions of Mac OS X, you may wish to create the disk image using DropDMG on Mac OS X 10.5.
Another option is to create a read-write disk image, manually tweak its view options on Mac OS
X 10.5, and then use DropDMG to convert it to a final format.

Note: There seems to be a bug in Mac OS X 10.6 that prevents background pictures from being
set if you have FileVault enabled.
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5.4 Advanced

Advanced o

BNEN —

Configurations Licenses

Temporary options: | Show if Option key is down v

Operations: || Always run with root access

This allows DropDMG to copy all files, regardless of their
permissions, without prompting you for a password.

|| Use less temporary disk space
In most cases this will be slower.

[ | Quit when done

Remove log entries: | Manually =

oy
N A

Command-line tool: | Install “dropdmg” Tool |

5.4.1 Temporary options

When DropDMG is creating or converting a disk image, it uses the options specified in the cur-
rent configuration. If you want to use slightly different options, you could go to the Configurations
preferences, duplicate the configuration, change it, make your image, and then delete the configura-
tion. However, it’s much easier to use temporary options. This lets you start with a configuration,
make some one-off changes, and then create your disk image without altering any of the saved
configurations.

Show if Option key is down
Select this option if you normally want to use the saved configurations, using temporary
options only when you drag a folder onto DropDMG while pressing the Option key.

Show unless Option key is down

Select this option if you usually make different types of disk images each time. DropDMG
will always bring up the temporary options window, unless you're pressing the Option key.
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You can also use the DropDMG: Ask for Options command in the Services menu to create a
disk image using temporary options.

| " E Tempuran,r Options Demo . |

Configuration: [ =) Compressed bzip2

Format: [ .dmg — smallest file, slower 10.4 :]

Encryption: [ Mone 10.2 :] | Set Passphrase... |

Segments: [ | Limit file sizeto  4.692 MB

License: [ None

Layout: [ Mone

Options: [_| Custom volume icon

[ | Internet-enabled
(] Optimize for restores

Destination: [ Mext to Source

MNames: [ Automatic

Source: || Delete after creating
I\_"T Delete after converting

Cancel ] E—Dﬂ—i

5.4.2 Always run with root access

If you downloaded DropDMG direct from C-Command

Normally, if DropDMG does not have the privileges that it needs in order to create a disk
image or archive, it will prompt you to authenticate by entering an administrator password.

53



This authentication lasts for a few minutes, or until you quit DropDMG (whichever happens
first).

If Always run with root access is checked, DropDMG will retain administrator access—
even between launches. This saves you from the trouble of having to keep entering your
password, and it makes it easier to run DropDMG unattended (for example, as part of an
automated, scheduled backup). However, this is a potential security risk. Anyone with access
to your copy of DropDMG will be able to access and modify any file on your Mac.

Note: In order to use Always run with root access, the DropDMG application must be
installed on your Mac’s startup volume.

If you purchased DropDMG from Apple’s Mac App Store

In order to create a disk image or archive from certain files, DropDMG will need root access.
You can give DropDMG this access by opening the Terminal application and entering these
two commands:

sudo chmod u+s /Applications/DropDMG.app/Contents/Frameworks/MJTFoundation.framework/Vers:
sudo chown root /Applications/DropDMG.app/Contents/Frameworks/MJTFoundation.framework/Vers

It will ask for your administrator password. This is a potential security risk. Anyone with
access to your copy of DropDMG will be able to access and modify any file on your Mac. You
can remove the root access by entering this command in Terminal:

sudo chmod u-s /Applications/DropDMG.app/Contents/Frameworks/MJTFoundation.framework/Vers:

5.4.3 Use less temporary disk space

With this option checked, DropDMG will only require free disk space on the destination volume
equal to the size of the final disk image file. This can make disk image creation much slower,
however. Additionally, when creating an encrypted disk image, all data written to the destination
volume will be encrypted.

With this option unchecked, disk image creation will generally be much faster (and the final com-
pressed disk image file may be slightly smaller), however DropDMG may require working space on
the destination volume of up to twice the size of the source folder. When creating an encrypted
disk image, the final disk image file will be encrypted, however temporary files will not. Thus, if
you plan to distribute the destination hard drive itself (rather than just the final .dmg file), you
should use Disk Utility to Erase Free Space securely.

Leaving Use less temporary disk space unchecked is generally the best choice, unless there is
little free space on the destination volume.
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5.4.4 Quit when done

If Quit when done is checked, DropDMG will quit itself when there are no more imaging or burn-
ing operations in progress. This means, for example, that you can drop a folder onto DropDMG,
and it will launch, do its work, and then quit.

5.4.5 Remove log entries

You can delete individual log entries by selecting them in the DropDMG window and pressing
delete. Use Edit > Select All to quickly clear the log.

The pop-up menu lets you set DropDMG to automatically delete old log entries When DropDMG
quits, After one day, After one week, After two weeks, After one month, or After one
year. If you set it to Manually, DropDMG will keep the log entries forever (unless you delete
them).

5.4.6 Command-line tool

DropDMG has a command-line tool called dropdmg that can create disk images and archives and
burn CDs and DVDs. This lets you control DropDMG from Terminal and automate it via shell
scripts.

To install the command-line tool, click the Install “dropdmg” Tool. Once installed, DropDMG
will automatically offer to update the tool when a new version is available.

For a list of the available options, type man dropdmg in Terminal.

The Sharing Licenses and Layouts section describes how you can use the dropdmg tool with licenses
and layouts that are stored outside of DropDMG, e.g. under version control.

95



® MM /Users/mjt — less — 383
dr mgil Dr-opOMG

HAME
dr = Commarnd-Lline lnterface for DropDMG
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dropdmg ——burn—image file...
dropdmg —burn-file file...
dr
DESCRIPTION
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Note: The dropdmg tool is not a freestanding utility. Rather, it controls the DropDMG application,
which it will launch as needed.

5.5 Esoteric Preferences

You can set esoteric DropDMG preferences by clicking the links on this page. Unlike with regular
preferences, you must generally quit and re-launch DropDMG in order for an esoteric preference
to take effect.
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Note: If you're viewing this page within the Help window in DropDMG, the links are not clickable.
To activate a link, Control-click on it, choose Copy Link, and paste the link into your Web
browser’s location bar.

AppendDateWithSeconds

When using the Append current date option, DropDMG usually uses the YYYY-MM-DD
format. You can also set it to use the YYYY-MM-DD-HHMMSS format. This is useful if
you will be creating more than one dated disk image on the same day and you want the files
to have unique names.

BlankBackgroundSize

When creating a disk image with a layout, DropDMG normally sets the size of the mounted
image window to the size of the background picture. If you don’t specify a background picture,
it uses 640x480. You can also set it to use 800x600.

CreateDevicelmages

DropDMG normally detects when you are trying to make a disk image of a volume and
creates a device image. Device images are exact copies, and creating them is faster. You may,
however, prefer that DropDMG create regular disk images of volumes, as this will give you
control over the volume name.

LayoutViewGridSize

DropDMG layouts ordinarily use a grid size of 16x16 pixels. You can temporarily ignore the
grid by holding down the Command key or change the grid size to 8x8.

6 Frequently Asked Questions

6.1 How can I make my disk images download properly?

Some Web servers have trouble handling plain .dmg files, because they don’t know what kind of file
they are. When people download the .dmg file, it can open in the Web browser instead of mounting
automatically. Or, with a bzip2-compressed image, Safari will change the file extension from .dmg
to .dmg.bz2, which causes the OS to think the file is damaged. In order to prevent these problems,
make sure that your Web server uses the correct MIME type for .dmg files. If you administer an
Apache-based server, you can ensure this by adding this line:

AddType application/x-apple-diskimage .dmg

to your .htaccess file.
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x-dropdmg://default?k=AppendDateWithSeconds&v=NO
x-dropdmg://default?k=AppendDateWithSeconds&v=YES
x-dropdmg://default?k=BlankBackgroundSize&v=%7B640,%20480%7D
x-dropdmg://default?k=BlankBackgroundSize&v=%7B800,%20600%7D
x-dropdmg://default?k=CreateDeviceImages&v=YES
x-dropdmg://default?k=CreateDeviceImages&v=NO
x-dropdmg://default?k=LayoutViewGridSize&v=16
x-dropdmg://default?k=LayoutViewGridSize&v=8

6.2 Why doesn’t my serial number work?

You need to enter the serial name and serial number exactly as they appear on your order confir-
mation e-mail. If you no longer have this e-mail, you can look up the name and number. Launch
DropDMG and choose Purchase from the DropDMG menu. Then click the Look Up My
Serial Number button.

6.3 Why does DropDMG try to connect to dreamhost.com when it starts up?

It’s checking to see whether there’s a newer version of DropDMG available. You can disable this
feature from the Software Update. .. window that’s accessible from the DropDMG menu.

6.4 What should I do if I get an error 491687

Try disabling your anti-virus software.

6.5 What information should I include when I report a problem?

All Types of Problems

It will be faster and easier to help you if your e-mail includes the following information:

The version of Mac OS X that you are using
Click on the Apple menu and choose About This Mac.

The version of DropDMG that you are using
Click on the DropDMG menu and choose About DropDMG.
Errors reported in the system log

In the Finder, click on the Go menu and choose Utilities. Open the Console application
and click on All Messages at the left of the window. (If All Messages is not visible,
first click Show Log List.)

To send in all the DropDMG log entries:
1. Type DropDMG in the Filter search field. (It may be necessary to click the
Earlier button at the bottom of the window to show more matching log entries.)
2. Click on a log entry.
3. Choose Edit > Select All.

4. Choose File > Save Selection As... and save the file as DropDMG. log on your
desktop.

5. Drag this file into your e-mail message to attach it.

If something isn’t working as you expect
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Please describe what you did, what happened, and what you expected to happen instead. If
possible, take a screenshot or two that illustrate the problem.

Screenshots
To take a screenshot, hold down the Apple and Shift keys and press the number 4. Then
use the mouse to select the area of the screen that you want to take a picture of. This
will create a file called Picture 1 on your desktop. Pressing the keys again will create
Picture 2, etc. You can drag these into the e-mail window to attach them to your
message. If you're using Apple Mail, be sure to set the Image Size pop-up menu at the
bottom of the message window to Actual Size.

If EagleFiler stops responding or freezes

Please open the Activity Monitor program (in the Utilities folder in your Applications
folder). Select EagleFiler in the list. When it is slow or hangs, choose Sample Process from
the View menu. Then save the resulting data to a file and submit it via e-mail32.

7 Legal Stuff

Distribution

Please distribute the unmodified DropDMG-3.1.3.dmg file on the Web, LANs, compilation CD-
ROMs, etc. You may not charge for it (beyond a reasonable cost for media) or distribute the
contents of the disk image file in isolation. You may not distribute your serial number.

Limited Warranty

The software is provided “as is,” without warranty of any kind, express or implied, including but not
limited to the warranties of merchantability, fitness for a particular purpose and noninfringement.
In no event shall the authors or copyright holders be liable for any claim, damages or other liability,
whether in an action of contract, tort or otherwise, arising from, out of or in connection with the
software or the use or other dealings in the software.

License

A license for DropDMG is good for one person or one computer. You may install it on one Mac,
and everyone sharing that Mac may use it (on that Mac). Alternatively, you may install it and
use it on multiple Macs (e.g. your desktop Mac and your laptop); then you (and no one else) may
use it on any of those Macs. For multiple users on multiple Macs, you should purchase multiple
licenses.

Copyright and Trademarks

DropDMG and this manual are copyright (© 2002-2012 by C-Command Software33. All rights

32pailto: eaglefiler@c-command.com
3mailto :mjt@c-command.com
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reserved.

DropDMG is a trademark of C-Command Software. Mac is a registered trademark of Apple
Computer. All other products mentioned are trademarks of their respective owners.

Components

The following open-source components are used in DropDMG:

e Regular expression support is provided by the PCRE?? library package, which is open source
software, written by Philip Hazel, and copyright by the University of Cambridge, England.

e Core Foundation?” is available under the terms of the Apple Public Source License?®°.

e Growl®” is Copyright © The Growl Project, 2004-2007 All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permit-
ted provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of
conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this
list of conditions and the following disclaimer in the documentation and/or other
materials provided with the distribution.

3. Neither the name of Growl nor the names of its contributors may be used to en-
dorse or promote products derived from this software without specific prior written
permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBU-
TORS “AS IS” AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT
NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FIT-
NESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL
THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, IN-
DIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS
OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)
HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CON-
TRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHER-
WISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF
ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

e Thanks to Allan Odgaard for some code snippets that are used in the Software Update
installer.

34nttp://www.pcre.org
35http://www.opensource.apple.com/darwinsource/10.4.10.x86/CF-368.28/
36http://www.opensource.apple.com/apsl/

3™http://growl.info
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8 Version History

3.1.3—May 9, 2012

DropDMG is now code-signed using a Developer ID certificate®® for Gatekeeper.
Layouts and custom volume icons now work with hybrid (.iso) disk images.
DropDMG’s helper tools are now 64-bit like the rest of the application.
Improved the reporting of unexpected errors.

DropDMG now logs more information when a layout item is missing from the source

folder.

Improved the What information should I include when I report a problem? section of
the manual.

Fixed a bug where the Compact Image. .. command didn’t work on Mac OS X 10.7 when
the computer was running on battery power.

Fixed a bug where Delete after converting didn’t work when converting to .iso
format.

Fixed a bug where DropDMG would report an error when converting a .iso disk image
to the same format.

DropDMG now requires Mac OS X 10.5.8 or later.

3.1.2—February 7, 2012

Added support for Growl notifications via GNTP (requires Mac OS X 10.7 or later).

When renaming a configuration, layout, or license in the preferences, you can now press
the Esc key to cancel.

Fixed a bug where DropDMG would log an error to the console when converting a ZIP
archive to a disk image.

3.1.1—November 16, 2011

Added support for Growl 1.33%.

DropDMG is now localized in Brazilian Portuguese.

Added 1024x1024 application icon.

Fixed a bug where the Add Icon... button didn’t constrain new icons to the grid.
Fixed a bug where the Add Icon... button didn’t let you add folder icons to a layout.

Fixed a bug that could cause a crash if there was an internal error launching a helper
tool.

3.1—October 4, 2011

3¥nttp://www.apple.com/macosx/mountain-lion/security.html
3nttp://growl.info
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DropDMG is much faster at creating large disk images under most circumstances, and
it now compresses disk images a bit more tightly. Added the Use less temporary disk
space preference, so that you can make DropDMG operate in the older, slower mode if
your destination volume is running out of space.

Disk image layouts can now contain text boxes, with your choice of fonts, styles, colors,
and shadows. Thus, it’s no longer necessary to fire up a graphics program to update the
text in your background picture.

Layout text boxes can contain placeholder variables, which DropDMG will replace when
creating the disk image. For example, if your disk image contains an application (e.g.
DropDMG.app), the text ${APP_SHORT_VERSION_STRING} will be replaced by the market-
ing version of the application (e.g. 3.1).

The Mount Image. .. command now has a Shadow file option that lets you mount a
read-only disk image as read-write. Any changes made to the mounted image will be
written to the adjacent shadow file. This can be useful, e.g. if you want to use Spotlight
to search a read-only disk image.

DropDMG now supports license agreements localized in Arabic, Greek, Russian, and
Ukrainian.

To ensure that background pictures display properly in the Finder, DropDMG now
reports an error if you give it a picture file that’s not 72dpi.

Many operations when editing a disk image layout are now undoable.

The license agreement editor text view now displays line breaks in the same places as
the text view that the system uses when mounting the disk image.

The Preferences window now supports full screen mode (requires Mac OS X 10.7).
Added the Burning a Lion Installation DVD section to the manual.

Fixed a bug where, when creating an encrypted disk image with no specified passphrase,
DropDMG sometimes failed to prompt for one.

Fixed a bug where creating a new language for a license agreement appeared to do
nothing if the license’s name was in edit mode.

Fixed a bug where the configuration/layout/license lists didn’t properly update if you
added an item while you were renaming another item.

Fixed a bug where the source size reported in the log when mounting a disk image only
counted the first segment.

Fixed a bug that could cause DropDMG to create a .tar.bz2 archive when you requested
.tar.

Fixed alignment of license button text fields.

Fixed a bug with re-personalizing the application via URL.

3.0.7—May 17, 2011

Fixed a bug where DropDMG would fail with a permissions error when creating a disk
image with a custom icon of a root-owned file, e.g. a purchase from the Mac App Store.
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Fixed a bug where, in rare cases, DropDMG could not create a disk image if a file with
its preferred temporary name already existed.

Fixed a bug creating images in .cdr format with custom icons or layouts.

Clarified the description of .cdr disk image format.

Adjusted the help page titles to fit better in the menu and search results.
3.0.6—March 11, 2011
e Fixed a bug where the command-line tool and Automator would time out during long
disk imaging operations.
e Fixed a bug where disk images with layouts sometimes ended up with too short a window.

e Fixed a bug where creating a disk image with a layout would sometimes fail if DropDMG
was running with root access.

e Fixed a bug that could cause a crash when verifying a folder containing circular symlinks.
e Improved the error message when the chosen destination folder isn’t writable.

e Improved the German localization.
3.0.5—February 25, 2011

e DropDMG 3.0.5 contained revisions for the Mac App Store but was not shipped directly
to customers.

3.0.4—November 15, 2010

e When creating a disk image with a layout, DropDMG now sets it to auto-open. This
ensures that CDs/DVDs burned from that disk image will auto-open when the disc is
inserted.

e Fixed a bug where invisible version control folders could prevent detached licenses from
working.

e Fixed a bug where Automator would time out during a long disk imaging operation.
3.0.3—October 5, 2010
e Fixed a bug where it didn’t work to simultaneously enter -—1icense-folder and —--layout-folder

from the command-line.

e Fixed a bug where some temporary folders would not be deleted if you canceled while
converting a disk image.

e Fixed a bug where the German and Italian localizations showed an incorrect version
number.

3.0.2—August 17, 2010

e DropDMG is now localized in French.

e Added toolbar buttons to the DropDMG window for directly opening the Layouts and
Licenses tabs of the Preferences window.
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e Added a preference to remove log entries When DropDMG quits.

e Creates more tightly compressed ZIP archives than previous versions of DropDMG or
the Finder (requires Mac OS X 10.6).

e Added a CreateDeviceImages esoteric preference, which lets you create regular disk
images instead of device images when dragging a volume onto DropDMG. This is slower
but gives the option of setting a custom volume name.

e Fixed a bug where DropDMG truncated the suggested volume and base names when
using the Ask option.

e Fixed a bug in the layout editor where retracting a marquee selection left the icons still
selected.

e Fixed a bug where DropDMG reported an error when converting encrypted . sparsebundle
disk images.

e Fixed a bug where using a detached license or layout could cause DropDMG to create
extra Info.plist files in nearby folders.

e When displaying an internal error, DropDMG now cleans it up and presents an abbre-
viated version to ensure that the window fits on screen. (The full error information is
still included when you click the Send E-mail button.)

e Worked around an OS bug that could prevent DropDMG from being able to open its
Preferences window.

e Tried to work around a problem where the software updater sometimes didn’t ask for
the permissions it needed to complete an update.

e Updated the disk image layout.
3.0.1—July 14, 2010

e If you try to enter a serial number for DropDMG 2.x, rather than just complaining that
it’s invalid, DropDMG now uses it to help you get a discounted or free upgrade and a
3.x serial number.

e Fixed a bug where creating a disk image from the Finder’s contextual menu or keyboard
shortcut sometimes didn’t work.

e Fixed a bug where selecting a folder from the New from Folder/File... dialog didn’t
work.

e Fixed an internal error that occurred if you changed a configuration option while renam-
ing a configuration.

e Fixed a bug that could prevent the Automator action from working.

e Fixed a regression where the -t argument to the dropdmg command-line tool wasn’t
recognized.

e Fixed a bug where the Base Name and Volume Name fields sometimes weren’t
editable when dragging and dropping onto the main window.

e Enabled undo for the Base Name and Volume Name text fields (requires Mac OS X
10.6 due to a bug in previous versions).
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Fixed a bug where DropDMG would show two Help menus after auto-updating the
command-line tool.

Fixed a bug where the Names pop-up menu text was too wide when using YYYY-MM-
DD-HHMMSS dates®.

Fixed the positioning of the log detail drawer.

Fixed a small memory leak.

The manual now recommends leaving space in a layout’s background picture for the
Finder window’s path bar.

Updated the tooltips in the configuration options.

Updated the localizations.

3.0—June 29, 2010

DropDMG is $24 for new users, $12 for previous DropDMG owners, and free for people who
bought DropDMG 2.x on or after June 20, 2008. There’s a 30-day fully-featured trial for new
users and upgraders.

Highlights

The user interface and disk imaging engine have been almost completely redesigned
and rewritten to make DropDMG easier to use and more robust.

The Layouts feature gives developers a WYSIWYG editor to set the background
picture, view options, and icon positions, making it easy to deploy Mac software to
their users.

The New Blank Disk Image... command lets you protect select folders using the
same encryption technology as FileVault but without its drawbacks.

Added support for the .sparsebundle, .sparseimage, and hybrid (.iso) disk im-
age formats.

The DropDMG window now has a customizable toolbar for quick access to commonly
used commands.

The Activity window consolidates progress information into a single window, rather
than having separate windows for each operation. Additionally, DropDMG now has
progress bars for bulk operations, so that you can see the overall progress (e.g. folder
6 of 10) in addition to the progress for the current operations.

DropDMG can now create device images of hard drives.

The Verify Image. .. command now works in the background and can verify a whole
folder of disk images at once. You can also bulk-verify multiple encrypted disk
images without having to keep re-entering the passphrase.

The Mount Image. .. command now works in the background and can mount multi-
ple disk images at once. You can also bulk-mount encrypted disk images that share
the same passphrase.

Added the Change Image Passphrase... command, which makes it much faster to
change the passphrase of an encrypted disk image.

“Onttp://c-command . com/dropdmg/manual-ah/esoteric-preferences
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The Join Files. .. command lets you recombine files that have been split into .001,
.002, etc. files.

Configurations

Configurations are now editable, and the Configurations window has been merged
into the Preferences window.

The Formats pop-up menu has been reorganized and provides more information
about the different formats and which versions of the OS they work with.

Added support for 256-bit AES encryption, which the NSA rates as secure enough
for TOP SECRET level documents.

Added the Optimize for restores option.

Added the Sizes pop-down menu, which makes it easy to select common sizes for
disk image segments.

The Show Passphrase button lets you check the passphrase for a configuration
without having to re-type it.

The dialogs for the New from Folder/File... and Convert Image/Archive... com-
mands now have pop-up menus to select which configuration to use.

The destination and names prompts have been combined into a single dialog.

If the chosen destination folder is not available (e.g. because its volume is offline)
DropDMG now displays a caution icon in the pop-up menu and will report an error
during the operation, rather than silently changing to Next to Source.

When choosing a configuration in the DropDMG window or from the Dock menu,
you can hold down the Option key to open the configuration for editing.
Configurations are now stored as individual .plist files, rather than in DropDMG’s
preferences file, so it’s easier to exchange them with other users and they work better
with Time Machine.

Optimizations

Creating encrypted disk images is faster and requires less temporary disk space.
Other types of operations can now run while DropDMG is waiting for a blank optical
disc to be inserted.

Improved the queuing of bulk operations to reduce disk contention and increase
performance.

DropDMG now runs as a 64-bit application under Mac OS X 10.6.

The DropDMG window now has a drawer that shows detailed information about
the selected log entry.

You can Control-click on log entries to perform operations on their files.

Log entries are now posted as Growl*!' notifications. If an operation has succeeded,
clicking on the Growl notification will reveal the destination file in the Finder (or
Path Finder??). If the operation has failed, clicking on the notification reveals the
log entry in DropDMG.

“nttp://growl.info
“nttp://www.cocoatech. com/pf . php
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e The Remove log entries preference lets you set DropDMG to auto-delete old log
entries after a specified amount of time.

e It is now possible to delete individual log entries manually.
e The log is now displayed as a table rather than a block of text.
e The log can now be set to only show errors.

e The log is now stored as a Core Data database rather than in DropDMG’s preferences
file. This makes reading and updating it faster and reduces DropDMG’s memory
usage.

License Agreements

e The separate windows for the license agreements list and the language editors have
been combined into the new Licenses tab of the Preferences window. The steps for
making a new localized license are much clearer now.

e Licenses can now customize the prompt text and button names that are presented
to the end-user.

e Added additional languages for localized licenses: Czech, Hungarian, Polish, Slovak,
Swedish, Turkish.

e License agreements are now stored as individual files, rather than in DropDMG’s
preferences file. This allows for sharing, storing them under version control, editing
using external applications, and better Time Machine backups.

e Added Spelling and Grammar, Substitutions, and Transformations to the
Edit menu, and also added menu commands for finding and replacing.

e You can hold down the Option key when choosing a license in the Configurations
tab to open it for editing.

e The license agreement editor now localizes the display of the language names.
Miscellaneous
e You can now choose whether DropDMG shows temporary options by default or only
when you hold down the Option key.

e Added the Compact Image. .. command, which reclaims free space from . sparseimage
and .sparsebundle files.

e The Get Image Info... command now displays the information in an outline rather
than a block of text.

e Custom badged icons for the mounted disk image volume are of much higher quality.
The icon is now rendered at up to 512x512 pixels, and there’s a separate optimized
version for each size (rather than scaling down the full-size rendering).

e The dropdmg command-line tool now has a man page.

e File and segment sizes are now displayed using base 10 megabytes, for consistency
with the Mac OS X 10.6 Finder.

o Remembers between launches which windows were open.

e DropDMG now auto-updates its command-line tool when you first launch a new
version of the application.

e The Create Disk Image/Archive Automator action is now compatible with Mac
0OS X 10.6.
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e Added Esoteric Preferences.

e Worked around an OS limitation that could prevent DropDMG from converting a
very large disk image into segments.

e Properly handles composed characters when truncating filenames.
e Made various improvements to the Software Update. .. user interface and engine.

e Improved the Purchase... window to make it easier to understand how the trial
period and serial numbers work.

e DropDMG now uses Mac OS X code signing??, which should reduce the number of
annoying keychain dialogs.

e Fixed a bug where DropDMG would continue trying to burn an encrypted disk
image after the user had failed to enter the proper passphrase.

e Fixed a bug with non-ASCII names and the command-line tool.

Removed

e DropDMG 3.0 requires Mac OS X 10.5 or later. Older versions* for Mac OS X 10.4
and 10.3 are still available.

e The Encoding option has been removed, since it’s no longer particularly useful to
create BinHex- or MacBinary-encoded disk images.

e Removed support for creating self-mounting .smi NDIF disk images, since all recent
versions of the OS have built-in support for disk images.

e Removed the keyboard shortcut for DropDMG’s command in the Services menu,
since Command-Shift-D was appropriated by the OS. You can use the Keyboard
pane of System Preferences to assign your own shortcut, if desired.

e Removed the option for making disk images auto-open. This is no longer necessary
since Mac OS X can now auto-open disk images that do not have this option set,
and this makes disk image creation much faster.

e Removed the Copy to Others button in the temporary options sheet, as this
functionality is superseded by configurations.

e Removed the contextual menu and Dock menu items for changing image formats.
This functionality is superseded by configurations.

e Removed support for creating and converting Stufflt archives.

e Removed support for creating ADC-compressed disk images. Zlib-compressed im-
ages are more efficient, and, due to other changes in Mac OS X’s disk imaging engine,
ADC images no longer provided any compatibility benefits.

e Removed the Fix Image. .. command, since Mac OS X will now mount disk images
regardless of whether they have the correct type and creator codes. The Control-
drag shortcut has been reassigned to the Verify Image. .. command.

2.8.6—September 4, 2009

e The Use custom icon for mounted image feature now works with Mac OS X 10.6.

e The crash reporter now works with Mac OS X 10.6.

“*nttp://developer.apple.com/mac/library/documentation/Security/Conceptual/CodeSigningGuide/Introduction/Introduc
“nttp://c-command . com/dropdmg/support#older-versions
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2.8.5—February 29, 2008
e Fixed bug where saved Automator workflows didn’t use the proper configuration when
running on Mac OS X 10.5.2.

e Fixed bug where certain disk images of application files created on Mac OS X 10.5.2
would mount on 10.3, but the Finder would refuse to open them. (The contents were
intact and accessible from other applications.)

2.8.4—January 21, 2008

e Fixed a regression in version 2.8.3 where DropDMG would delete the source file/folder if
you were creating a segmented disk image next to the source and there was not enough
disk space.

2.8.3—January 8, 2008

e Fixed bug where a .dmg file would not mount on Mac OS X 10.3 and earlier if you
created it on an Intel-based Mac running Mac OS X 10.5 and the image contained just
a single package file (e.g. an application).

e Fixed bug where Append Current Date didn’t work properly when the original
file/folder had a very long name.

e Fixed bug where images converted from Zip archives were owned by root.
e Faster at creating images of packages when running on Mac OS X 10.5.

e Fixed bug restoring the selected row after editing a configuration name.
e Carriage returns are no longer allowed in configuration names.

e Fixed bug where some preferences items were incorrectly enabled when showing a tem-
porary preferences sheet for a conversion operation.

e More detailed logging of burn errors.
e The software updater is better at handling invalid downloads folders.

e Updated Spanish localization.
2.8.2—November 14, 2007

e Fixed bug where the Apple Help didn’t work on Mac OS X 10.5.

e Added high-resolution version of the application icon.

¢ Fixed bug where DropDMG could crash when canceling an operation.

e Fixed bug where DropDMG would sometimes return an incorrect destination path back
to a script.

2.8.1—July 31, 2007

e If the destination folder is inside the source folder, DropDMG will now report an error

and ask you to pick a different folder, rather than silently using Next To Source.

e Fixed bug that could cause a crash after verifying or mounting an image.
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e DropDMG now accepts . IS0 images (uppercase extension from the Windows world) and
treats them as .iso.

e Fixed bug where DropDMG wouldn’t let you quit after certain types of burn failures.

e The Software Update... feature now checks whether the updated version can run on
your installed version of Mac OS X.

e Fixed bug where the Software Update. .. checker didn’t always re-check for new updates.
e Modernized the crash reporter code.

e Updated Dutch and Italian localizations.

e Fixed help book icon.

2.8—April 4, 2007

e Improved compatibility with pre-release versions of Mac OS X 10.5.

e Passphrases are now set in a separate dialog rather than directly in the preferences
window, and this has been combined with the old Confirm Passphrase feature. This
makes it easier to verify a passphrase when you enter it.

e DropDMG now accesses the keychain only when necessary, so it won’t prompt you to
unlock the keychain if you’re creating an image that doesn’t have a passphrase.

e The Software Update... checker now works behind an HTTP proxy, and the auto-
updater is compatible with FileVault.

e Reorganized the manual and added Burning Backups of CDs/DVDs and Transferring
Files Securely sections.

e When creating an image of an application or installer package, DropDMG no longer
includes file extension in the image name.

e Worked around -39 error from hdiutil when converting very large images with lots of
files.

e Auto-open is now off by default, since it slows down image creation, and on Mac OS X
10.4 and later the OS will auto-mount images automatically, anyway.

e Fixed bug where Burn Folder/File... treated packages as folders rather than as files.
e Better recovery from -35 errors when doing image post-processing.
e Fixed bugs in enabling and disabling Always Run With Root Access menu command.

e Fixed bug where the Services menu commands could appear in French if you were using
a British English system.

e Fixed bug remembering a recent folder that had a slash in its name.
e Fixed error when initiating a burn via AppleScript.

e Fixed small memory leak.

e Better names for temporary folders.

e Added keyboard shortcut for Hide Others.

e Added Spanish localization.
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2.7.9—October 18, 2006

Worked around OS bug that could cause crashes when editing license agreements.
Fixed bug when converting multiple archives simultaneously using Stufflt Expander.

Rewrote the Software Update. .. feature. When a new version is available, it can now
show you the release notes. DropDMG now downloads the new version itself, rather
than relying on your browser. The Download & Install button will cause DropDMG
to auto-update itself to the latest version.

Added recommended segment sizes to the manual and tooltip.

If no windows are open when you click on DropDMG’s icon in the Dock, it will now
open the Status window.

The Volume Name field is ignored when creating a device image, so it’s now disabled
in that case.

Aliases in the Recent Folders folder are now created with icons.
Dates in the log now follow the user’s preferred short format.

Fixed bug where it was possible to change the destination folder without the active
configuration changing to (custom).

Fixed bug where clicking the Confirm button could change the configuration to (cus-
tom).

Fixed regression where DropDMG didn’t set the image name based on the localized
name of the source file/folder.

Fixed a small memory leak when making custom icons.
Fixed bug converting multiple archives from the same folder.
The segment size field is now disabled when unchecked.
Fixed bug with display of remaining demo time.

Fixed bug with Purchase window sheet.

More code modernization and bullet-proofing.

Made various localization, documentation, and error message improvements.

2.7.8—July 13, 2006

Fixed regression where double-clicking a license agreement sometimes wouldn’t open its
editor window.

2.7.7—June 29, 2006

The Get Image Info... and image conversion features now support .iso disk images.
Various code modernization and bullet-proofing throughout.

Added Protecting Your Files With Encryption section to the manual.

Made a change to prevent a rare crash when closing the license agreement editor window.

Fixed bug that could cause a crash when closing the application-modal progress window.
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Fixed bug where editing a license agreement’s contents would change the active config-
uration to “(custom).”

Fixed bug where you could create an image of the destination folder inside itself.

Fixed bug where DropDMG could crash when running in Danish.

e Fixed various localization bugs.
2.7.6—March 28, 2006

e DropDMG can now create images from files/folders/volumes whose names contain the
/ character (: at the Unix level).

DropDMG can now burn images that are in .cdr format.

Slightly faster at creating disk images.

Improved the display of the demo time remaining.

Various documentation improvements.

Updated the localizations.
2.7.5—January 25, 2006

e DropDMG is now a universal binary*.
e You can now initiate burns using the dropdmg command-line tool.

e Rather than typing (or copying and pasting) your name and serial number to personalize
DropDMG, you can now click the x-dropdmg:// URL that’s sent to you when you
purchase?® DropDMG or get a serial number reminder?”.

e Errors encountered while preparing to create an image are no longer reported twice.
e Mounting errors are now displayed properly.

e Improved display of keychain errors.

e Added Danish localization and updated the other localizations.

e Made various improvements to the manual.
2.7.4—October 25, 2005

e Fixed bug where DropDMG would create a blank image when running on Mac OS X
10.3 and given a file or document package (i.e. not a folder or application).

2.7.3—October 25, 2005

e You can now view and set the current configuration from DropDMG’s Dock menu.

e Added “Expand Disk Image” Automator action, which replaces a disk image with a
folder containing the image’s contents. You can create an “Expand Image” contextual
menu item in the Finder by creating a single-step Automator workflow with this action
and saving it as a Finder plug-in.

“http://www.apple.com/universal/
4nttp://c-command . com/store/
“Thttp://c-command.com/sn
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Problems with the destination folder are now reported using the “choose destination”
sheet instead of in a separate alert.

The software update feature now shows a sheet instead of an alert when there’s a new
version, so it won’t interfere with scripted operations.

Fixed regression where DropDMG would complain at launch if one of the configurations’
destination folders didn’t exist.

Fixed bug where DropDMG would waste CPU time animating an off-screen progress
bar after finishing an operation.

Added Technical Support & Feedback item to Help menu.
Updated eSellerate engine and PCRE.

2.7.2—September 22, 2005

You can now drag and drop anywhere on DropDMG’s status window, rather than just
on the top part of it.

Fixed bug where DropDMG was incompatible with Stufflt Expander 10.

DropDMG now reports an error if you specify a destination folder that doesn’t exist,
rather than silently picking a fallback folder.

Better error messages when DropDMG doesn’t find a file in the expected place.

The command-line tool now treats the empty string as an invalid destination folder
instead of (as with AppleScript) treating it as a flag to indicate that the user should
be prompted to specify a folder. This should reduce unexpected behavior when running
DropDMG via a shell script that doesn’t properly quote the command-line arguments.

Errors during burning are now presented using a sheet, rather than just being logged.

No longer shows an error message if you try to install the command-line tool and then
cancel out of the authorization dialog.

Updated the Italian localization.

2.7.1—August 22, 2005

You can now erase rewritable discs before burning.
Fixed regression where DropDMG could crash when converting an image to an archive.

Fixed bug where DropDMG couldn’t convert images with license agreements into archives
or mount them.

Worked around hdiutil bug for more reliable imaging of certain non-optical volumes.

Fixed regression where the command-line tool didn’t work on Mac OS X 10.3.

2.7—August 15, 2005

Added commands for burning folders, files, and disk images. As a shortcut, you can
initiate a burn by dragging and dropping onto the status window or the DropDMG icon
while holding down the Shift key. Hold down Option and Shift when dropping a disk
image if you want to burn the image as a file, rather than burning its contents.
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Added smooth determinate progress bars for the longer steps when creating disk images
(requires Mac OS X 10.4).

Progress windows now have a cancel button, an icon showing the kind of file that’s being
created, and an icon and title bar menu that show the source file or folder.

Added Quit When Done option; if selected, DropDMG will quit when there are no longer
any image, archive, or burn operations in progress.

The status window now has a pop-up menu for displaying and changing the current
configuration.

Better creation of device images from multi-partition devices.

Progress windows are now tiled (so they don’t overlap), and DropDMG is better at
remembering where you like to position them. Dragging a progress window sets the
preferred location for new progress windows.

The following File menu commands can now accept multiple selection, so that you can
operate on more than one image at a time: Fix Image. .., Get Image Info..., Mount
Image (with Owners)..., Verify Image Checksum.. ..

Improved scriptability. You can now access DropDMG’s windows, menus, and other in-
terface elements from AppleScript. You can also access the current imaging and burning
operations and cancel them. You can initiate burns from AppleScript.

The Automator action is now a universal binary.

The dropdmg command-line tool now properly communicates with the DropDMG appli-
cation when running on Intel.

Fixed bug where image creation could fail with an error when creating an image on an
external volume, depending on the lengths of the source and destination paths.

Fixed regression where file packages weren’t wrapped when DropDMG was running with
root access.

Fixed bug where Sanitize for Servers didn’t account for file names that were entirely
non-ASCII characters.

Fixed bug where DropDMG would sometimes fail to remove an extra folder layer when
converting from Zip format.

Fixed bug where the Edit Configurations window allowed multiple selection.

Fixed bug that could cause a crash when creating a disk image if the OS reported an
error at exactly the wrong moment.

The Purchase window now makes it more clear when the serial number has been suc-
cessfully entered. Merged the Web Purchase. .. and Instant Purchase. .. buttons.

Adjusted the way the remaining demo time is displayed.

Updated Czech, Dutch, French, and Italian localizations.

2.6.3—June 22, 2005

Fixed regression where DropDMG would report an error when converting a .dmg image
to read-write format.
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Fixed regression where the license agreement editor didn’t work on Mac OS X 10.3.

2.6.2—June 20, 2005

Fixed regression where DropDMG would halt with a permissions error when creating an
image from a lone file and running on Mac OS X 10.3.

2.6.1—June 20, 2005

DropDMG can now create .dmg disk images that are internally compressed using bzip2.
These images can only be mounted on Mac OS X 10.4 and later, but they are often
much smaller than zlib-compressed disk images.

Made various optimizations for faster disk image creation.

Added Mount Image (with Owners)... command. This lets you copy files off an
image with their Unix ownership intact. (Normally, when you let the OS mount an
image, it pretends that all the files are owned by you.)

The Add Agreement... command is now enabled even when the License Agree-
ments window isn’t open. This should prevent people from being confused about how
to create a new agreement.

The Append Current Date option is now applied only when creating new images,
not when converting.

If you tell DropDMG to segment an image/archive, and it ends up being smaller than
the segment size that you chose, DropDMG will no longer wrap the output files in a
folder (since there’s only one).

The keyboard shortcut for Open Configurations is now Command-Option-,.

Worked around some Tiger issues that could cause DropDMG to halt part way through
creating an image.

Worked around bug in Tiger where .bz2 and .gz files would have .dmg type and creator
codes, which could cause problems opening them.

Worked around Tiger issue so that it’s once again possible to remove a license agreement
by converting (using None as the agreement).

Better cleanup if there’s an error creating the image.
DropDMG no longer complains when there’s no default keychain.
.mailbundle folders are now treated as packages, even though technically they aren’t.

Filename uniquing is now smarter when there are two extensions. So, for example, you’ll
end up with Foo-1.tar.bz2 instead of Foo.tar-1.bz2.

Fixed bug where sometimes custom icons didn’t work if you created multiple images
simultaneously.

Fixed bug where images created from volumes couldn’t be Internet-enabled.

Fixed bug where dragging a folder onto the Preferences window (to change the desti-
nation) didn’t change the selected configuration to (custom).

Fixed bug where Stufflt X and Tar were always enabled in the contextual menu.
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e Fixed bug where Tar archive creation wasn’t package-savvy.

e Fixed bug where Zip archives of single files contained an extra folder layer.

e Added --version switch to the dropdmg tool.

e The license agreement editor is faster at auto-saving any changes that you make.

e The demo reminder window updates the number of days remaining if you leave DropDMG
running for days or weeks at a time.

e Fixed bug where DropDMG could get into a state where it was permanently waiting for
other operations to complete.

e Fixed bug that could cause a crash when using the Instant Purchase feature.

e Updated French and Italian localizations. Added Dutch localization.
2.6—April 29, 2005

e Works with Mac OS X 10.4 (Tiger).
e DropDMG now has an Automator action.

e Can now create Mac OS X 10.4 Tar archives (.tar, .tar.gz, .tar.bz2) that support Mac
resource forks.

e Added Append Current Date and Sanitize for Servers name processing options.
e Can now create uncompressed read-only and read-write NDIF .img disk images.

e DropDMG is smarter about picking which file to use to create a custom icon.

e Added configuration name AppleScript parameter.

e Fixed bug where images sometimes weren’t created large enough to hold all the files.
e Fixed bug where script errors were only reported in abbreviated form.

e Added Edit Configurations to the DropDMG menu.

e Added keyboard shortcuts for opening the Edit Configurations window and for saving
the current configuration.

e Worked around the OS to prevent DropDMG from sometimes being dropped from the
Services menu.

e Window order of the Preferences window is preserved when closing the Configura-
tions window.

e Updated to eSellerate Engine 3.6.1.

e Improved serial number name entry.

e The Apple Help is now multiple linked pages, rather than a single page, so you can now
use Help Viewer’s search box.

2.5.3—February 7, 2005

e Fixed bug where some valid files weren’t choosable in the open dialogs.
e Update Czech localization.

e Improved name and serial number entry.
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2.5.2—January 24, 2005

Fixed bug where the volume permissions would be incorrect when making an image
directly from a file.

Added French localization.
Updated Czech localization.

2.5.1—January 11, 2005

Fixed bug where the BinHex and MacBinary encoders didn’t preserve non-ASCII file-
name characters.

Fixed bug where special handling of file packages was sometimes disabled.

When there are many simultaneous operations, DropDMG will queue some of them.
This improves performance and works around some hdiutil limitations.

Added Always Run With Root Access option.

When prompting for file and volume names, DropDMG is smarter about when to remove
the file extension in its suggested name.

Relaxed requirement that the source item’s containing path doesn’t contain a slash
(colon).

Now sets the owner and permissions of the disk image root to match the source folder.
Added help button to the preferences window.
Added Czech and Italian localizations.

2.5—December 7, 2004

Can now create archives in Panther’s Zip format; can convert Zip archives to images and
vice-versa.

DropDMG can now create Stufflt X archives, convert Stufflt archives to disk images,
and vice-versa.

Can now convert .tar, .tgz, .tar.gz, and .tar.bz2 archives to disk images (as well
as to .zip and .sitx).

Added support for .cdr (DVD/CD-R master) images.
DropDMG can create a custom icon for the mounted image.

You can now save named configurations of DropDMG’s preferences. By switching be-
tween different configurations, you can instantly recall different combinations of options.

When you ask DropDMG to create an image from a volume, it automatically creates a
device image, an exact copy of the volume, which is bootable (if original volume is).

DropDMG now has a system service, which lets you easily create images/archives from
items selected in the Finder, without DropDMG being open or in the Dock.

Added Mount Image At... command, which lets you mount images at arbitrary loca-
tions in the filesystem, rather than on the desktop.

Add Ask Later option, which makes DropDMG prompt you for a destination folder
each time it needs to save an image or archive.
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Added Confirm button to let you verify a passphrase after typing it.

DropDMG can now process multiple commands from AppleScript or the command line
at the same time.

Uses much less memory when computing folder sizes.

Launches faster.

The license agreement editor now supports find and replace.

The log and image info windows now support the Find command.

Lots of minor interface tweaks (window zooming, folder abbreviations, checkbox and
button enabling etc, keyboard shortcuts, new window manipulation menu commands.).

When creating encrypted images, the passphrase is now sent to hdiutil securely using
a pipe instead of on the command line.

A Cancel button is now available when you’re prompted to enter image and volume
names.

When creating a segmented image or archive, the segments are now placed in a newly
created folder.

Normalizes serial number case when personalizing, to make it less error-prone.

You can hold down the Option key when clicking OK to dismiss multiple temporary
preferences sheets at once.

If the chosen destination folder is read-only, DropDMG now prompts for a new destina-
tion folder rather than aborting with an error.

When you try to delete a license agreement, DropDMG now shows an alert sheet to
make sure that’s what you really meant.

The returning immediately AppleScript parameter is no longer needed and has been
removed. If you want the AppleScript command to return before the operation is com-
plete, use a standard AppleScript with timeout block.

The create image AppleScript command now returns the path of the created im-
age/archive. The command-line tool prints the path to standard output.

The When Imaging a Package option has been removed from the preferences, but is
still available via AppleScript and the command line.

When creating an image, DropDMG now preserves ownerships and permissions, rather
than just permissions. (This will not be evident unless you uncheck Ignore ownership
on this volume after mounting the image.)

Fixed bug where you’d have to authenticate more often than necessary.

Fixed bug where relative paths did not work with the dropdmg tool’s --destination
switch.

Fixed bug where top-level symlinks were resolved instead of being copied as links.

Fixed bug where it was possible to rename a license agreement, giving it the same name
as another agreement.

Fixed bug where DropDMG would sometimes return a “permission denied” error when
calculating the space necessary to image a folder. Now, it will instead prompt for an
administrator password.
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Fixed bug where sometimes you’d be prompted for a password after already entering
one in the preferences sheet.

DropDMG now requires Mac OS X 10.3 or later.

2.2—October 16, 2003

Added dropdmg tool for creating images from the command-line.

You can now create an image from a file by dropping it on DropDMG; you no longer
have to “wrap” the file in a folder.

You can now specify the passphrase for an encrypted image via AppleScript.

Can save a passphrase in the system Keychain, so that you can encrypt multiple images
using the same passphrase, without having to keep typing it.

Lets you authenticate as an administrator to copy protected files to an image.
Images can now be encoded with BinHex.

You can now drag a file or folder onto the preferences to set the destination.
License agreements can use non-roman characters.

Added Get Image Info... command.

Added Verify Image Checksum. .. command.

Added crash reporter.

Added software update version checker.

Faster MacBinary encoding.

Uses less memory when dealing with lots of files.

The destination pop-up menu now includes icons.

Rather than nagging when unregistered, DropDMG now has a 30-day/20-launch trial
period.

Fixed bug that caused an error when creating more than one self-mounting image simul-
taneously.

Fixed bug where DropDMG never prompted for volume and image names when you
used a temporary preferences sheet.

DropDMG now requires Mac OS X 10.2 or later.

2.1.1—July 21, 2003

Fixed bug where converting a .dmg file created by Disk Copy to .img or .smi caused
the .dmg file to remain in use so that it couldn’t be deleted, or its volume ejected.

Adding license agreements to images now works on Panther.

Fixed open/save dialog prompts to be more in line with the Aqua Human Interface
Guidelines.

2.1—April 24, 2003

Remembers recent and favorite destination folders.
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Can create Internet-enabled disk images.

Simplified the drag modifiers, the preferences window, and the scripting interface.
Can move the source folder to the trash after creating an image.

Can choose the destination folder when converting.

You can now specify preferences overrides using one sheet per image, rather than a single
modal dialog.

You can now set the volume name and image name from the scripting interface.

Added a returning immediately scripting parameter. This lets you control whether
the script waits for DropDMG to finish creating the image.

You can now use tildes in paths when scripting DropDMG.

Suggests localized image names, when possible, and omits hidden extensions, so that
you don’t end up with, e.g., a .app.dng file.

The license agreement editor is much more responsive.
You can set the encoding from the DropDMG Status window’s contextual menu.
Can now encode .dmg images with MacBinary.

Updated the MacBinary encoder for compatibility with Apple’s JDK 1.4.1. (In the
latest JDK, Apple removed support for JDirect, which the old MacBinary encoder relied
upon.)

Fixed bug where DropDMG couldn’t image a folder with more than 100 or so top-level
items.

Worked around problem where some .dmg images created with Disk Copy could not be
converted to .img or .smi.

Fixed license agreement assertion failure bug.
DropDMG will no longer let you quit while an image operation is in progress.

The agreement editor window zooms to the width of the text field that Disk Copy will
use to display the agreement when the image is mounted.

When you drag something over the DropDMG Status window, its instructional text
changes to tell you the meanings of the modifier keys.

The DropDMG Status window is closable (if you register).
License agreements remember their window positions across renames.
The License Agreements window is printable.

The DropDMG Status window zooms to a reasonable width instead of the whole
screen.

The DropDMG Status window summary shows more of the current preferences.
The progress bar is finer-grained.

The key equivalent for Delete Selection is Command-Delete instead of Command-D.
Better error messages.

DropDMG is better about picking fresh names for its temporary files.
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The Registration window is smarter about ignoring whitespace and control characters
that can be introduced when pasting in a serial number.

2.0—October 23, 2002

Converts dropped images to the format specified in the preferences when you hold down
Control-Shift.

Hold down Option when dropping a folder or image to specify settings to be used for
that item (temporarily overriding the preferences).

Makes self-mounting NDIF images (SMIs). This is the only kind of image that supports
license agreements on both 9 and X.

Creates smaller zlib-compressed images when running on 10.2 and later. (The images
are still compatible with 10.1’s Disk Copy.)

You can now choose to post-compress with BZip2 instead of GZip. BZip2 is slower than
GZip but creates smaller files.

Improved the layout of the preferences window.
Faster at copying files to the image when running on 10.2 and later.

Worked around 10.2 bug that caused errors when a file or folder name contained a slash
(as shown in the Finder).

Worked around OS X bug that prevented copying files larger than about 1 GB.
New application icon.

Compiled with GCC 3.

No longer calls thread-unsafe parts of Carbon from child threads.

Prevents the user from making a read-write image with a license agreement, rather than
stopping midway through with an error message saying that this wasn’t possible.

The status window no longer looks as though it will accept the drop when you try to
drop a .dmg file that doesn’t need metadata fixing.

Changed File menu text and keyboard shortcuts to more closely match 10.2’s Disk Copy.
The about box and registration window now use the design first seen in SpamSieve.
The log no longer uses the large system font under 10.2.

Better error message if you try to image the startup volume.

Fixed bug where images with license agreements contained duplicate styl resources.

1.7.3—August 17, 2002

Fixed bug that could make DropDMG crash when you clicked the Include license
agreement checkbox.

The spelling commands now have the standard keyboard equivalents.

The Preferences. .. keyboard equivalent has been changed to Command-,.

1.7.2—August 15, 2002
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Removed spurious error message when changing the attributes of text in a license agree-
ment.

1.7.1—August 12, 2002

The user interface no longer gets out of sync when you modify license agreements.

Changes to the segment size take effect immediately; you no longer have to type Tab or
Return to commit them.

The status window updates faster.

1.7—August 12, 2002

Added support for license agreements. License agreements support rich text and may
be localized.

The image destination path is now stored abbreviated with a tilde, if possible. This
should help people who have multiple boot partitions.

The log is printable.
Finer-grained progress bar and status text.

If adding the requisite filename extensions would make the requested image name longer
than the limit, DropDMG will now quietly truncate the name rather than stopping with
an error.

NDIF images are now created with filenames of 31 characters or less, so that there won’t
be any name mangling when they’re viewed in Mac OS 9.

DropDMG now truncates .dmg volume names to 62 characters and .img volume names
to 27.

Fixed bug where DropDMG could deadlock after certain kinds of errors.

Fixed bug where DropDMG sometimes didn’t detect filename collisions until after it
started making the image.

Fixed bug where DropDMG would overwrite pre-existing .dmgpart files if the first seg-
ment was not present and the newly created image happened to have the same name.

Renamed some File menu commands.

1.6—July 15, 2002

Option to make images auto-open. When you mount an image, its window opens in
the Finder. Previously, there might have been no visual indication that the image had
mounted, depending on how the user’s Finder preferences were set.

The status window has a contextual menu for quickly changing common preferences.

You can optionally set the names of the image file and volume, instead of having them
based on the name of the folder.

Documentation is now included in Apple Help (HTML) format as well as PDF.

Contains a menu command for clearing the log.
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No longer fails when copying files for which the user only has read privileges. Previously,
DropDMG would copy the file and permissions and then report a permissions error when
it tried to set the catalog information of the copy, which wasn’t writable.

The radio buttons for selecting where the image will be saved are no longer linked to
the image destination text field. That is, tabbing of the text field no longer affects the
radio button’s selection, making the preferences more friendly for keyboard navigators.

1.5—May 2, 2002

Multi-threading—DropDMG can create more than one image at a time, and the interface
remains responsive.

Can divide large images into multiple segments of fixed size.

Creates uncompressed read-only images, which often compress better with GZip than
internally-compressed image files do.

Creates read-write images.

Encodes Mac OS 9 .img images with MacBinary so that they can be transferred on the
Internet.

The status window displays a log that shows all the completed operations and errors.
The status window now shows all the format options that are in effect.
Faster copying of Mac metadata.

Worked around Apple bug that sometimes caused errors when creating large images.
hdiutil crashed when expanding sparse images.

Fixed bug where DropDMG mistakenly resolved symlinks when copying Mac metadata.
This had caused some metadata not to be copied, and also caused image creation to fail
if the user didn’t have write access to the original file.

Fixed regression where DropDMG sometimes didn’t complain when the destination
folder was inside the source folder.

Tries several times to eject images, rather than giving up immediately.
More detailed reporting of file copy errors.
More accurate reporting of what state the image creation process is in when errors occur.

Mailing list for version announcements has a Web interface.

1.3.1—March 11, 2002

You can now create images by dragging and dropping folders into the status window.
The status window’s indication of the progress is more accurate.
Fixed regression in which images couldn’t be created on non-boot volumes.

Fixed regression in which images couldn’t be created in ~/Desktop if the destination
folder had never been manually set.

1.3—February 25, 2002
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You can now choose whether images are saved next to the source folder, or in a user-

defined folder.
Volume images are now created in ~/Desktop by default (instead of /Volumes).

Resolved problem in which DropDMG tried to replace invisible system files on the image,
if the source folder contained items with the same names.

The format parameter is now optional when creating images with AppleScript.
Notifies the system after fixing an image’s type and creator.

Fixed bug in which DropDMG would report the wrong file as the cause of a copy error.
The keyboard loop in the Preferences window should work again.

The status window no longer flickers when the program first opens.

The distribution is smaller, since the manual uses fewer images.

1.2.1—February 11, 2002

Uses Carbon to preserve Finder info (e.g. the locked, stationery, and custom icon bits)
when copying files.

1.2—February 3, 2002

All options are now available from the scripting interface.

No longer requires Mac OS X’s optional “BSD Subsystem” installation.
Optionally post-compresses DMGs with GZip.

Fixes type and creator codes of DMGs.

Preferences window is easier to use; now, enablement is only tied to the Image Format
radio buttons.

Capitalizations now follow the Aqua Human Interface Guidelines.

1.1—January 28, 2002

Supports ADC and NDIF compression for compatibility with Mac OS 10.0.x and Mac
OS 9, respectively.

Supports encrypted compressed images in the zlib and ADC formats.

Optionally detects packages so that you end up with a mounted image containing the
package instead of a mounted image that the Finder thinks is a package.

Copies locked files to images (instead of stopping with an access error).

Images’ logical sizes are smaller; this should slightly reduce their physical sizes and
reduce mount times.

Accepts drops of all file types (including packages); if DropDMG doesn’t know how to
handle a dropped file it will just ignore it.

The Make Image From Folder. .. menu command lets you choose packages and sub-
folders of packages (instead of just vanilla folders).

Minor UI tweaks.

1.0—January 21, 2002

First public release.
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